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1. Introduction

GlobalVision is an all-in-one inspection platform used to compare two documents (ex: a sample against
a master) to encounter and eliminate printing errors, also to generate a detailed difference report outlining
each error and decisions taken to resolve them.

Each difference is highlighted with individual level and comment, to enhance the in-depth proofing and
reviewing experience.

The highlights of the solution’s functions include:

e Ability to compare electronic files of the following file types: 1-BIT TIF, Al, BMP, DOC/ DOCX,
HTML/ HTM, JPEG, LEN, PDF, PNG, RTF, TIF, TXT, XLS/ XLSX, XML, PPT.

e Ability to compare scanned and electronic files (labels, cartons, and inserts).
e Ability to compare a printed component on cylinders and tubes to an electronic file.
e Ability to inspect multi-page documents (e.g. booklets).

e Ability to identify missing, added, or modified content such as text, print defects, and color
differences.

e Ability to detect spelling errors.

e Ability to measure and compare color points.

e Ability to review differences and add comments and levels.
e Ability to append inspection results.

e Ability to generate PDF reports with comments and levels.
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2. Getting Started
The following sections describe the log-in process and how user accounts are created.

2.1 Creating User Account
Once your administrator creates your account, an email gets sent out, assuming applicable SMTP
settings have been configured as required. It has the subject line: “GlobalVision user account created”

and contains your User Name and a temporary password. Your next step is to log in and create your new
password. For more information on creating user accounts, please consult the Administration Guide.

2.1. Login

To log in to the Application:
e Click the Application shortcut on your desktop. The Login window displays.

[ JoX ] Login

GlobalVision®
Type in your user name, password and then click Login

[ 1 acknowledge that | have read and accept the Global Vision

and the

Forgot password

Login Window

e Click through on each of the End User License Agreement and Privacy Policy links and check
the box acknowledging you have read and accept them.
e Enter your User Name and Password and click Login.

e [f this is the first time you are logging in or if an administrator has reset your password, a
"Temporary password" message displays. Click OK and the Password window displays, allowing
you to create a new password:
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| JoN | Password

old password [

Confirm Password |

Cancel

Password Window

Enter the temporary password you have received via email or from your administrator in the Old
Password text box.

Enter your new password in the New Password text box.

Enter your new password again in the Confirm Password text box.

Click Accept and OK once the notification window displays.

Password changed.

The Main View displays. You are now ready to start setting up your inspection.

NOTE: The Application saves your active window upon logout (not exit) and displays it at your
next log-in. For example, if the Inspection View was active when you logged out, the Application
displays it at your next log-in.
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Master Toolbar Sample Toolbar

Master Panel Sample Panel

Main View
2.3 Change Password
To change your password:

e Click Menu E > Change Password.
e The Password window displays, letting you create a new password:

® 9 Password

Contirm Password |

Password Window

Enter your old password in the Old Password text box.

Enter your new password in the New Password text box.

Enter your new password again in the Confirm Password text box.

Click Accept. Click OK once the “Password changed” notification window displays.
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Password changed.

2.4 Help
The following options are available to you upon clicking the Help icon:

Select Give Feedback to request new features or report bugs.

Select GlobalVision Support to link to the GlobalVision online knowledge base.
Select Video Tutorials to link to a list of watchable how-to videos.

Select Shortcuts to display all keyboard shortcuts.

Select About to get version details about the Application.

Select Licensing to enter and refer to serial-number and company-name information.

2.5 Logout/ Exit

To log out of the Application:

e Click Menu E > Logout to save your session and return to the Login window.
e Click the X on the top right of the window to exit the Application.
NOTE On a Mac® operating system, click X on the top left of the window to exit the Application.

2.6 Icons and Menus

LABEL ICON DESCRIPTION

MAIN

FILE MENU DROP-DOWN OPTIONS:
FILE e NEWJOB
e LOAD MASTER

e LOAD SAMPLE

Iy CLEAR ALL INSPECTION RESULTS AND RETURN TO THE
RESET MAIN VIEW
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RETAIN ALL INSPECTION RESULTS AND RETURN TO THE

BACK MAIN VIEW
FORWARD RETURN TO THE INSPECTION VIEW
GRAPHICS
e, GRAPHICS INSPECTION PERFORMED WHEN SELECTED

TEXT INSPECTION TEXT INSPECTION PERFORMED WHEN SELECTED

SPELLING
INSPECTION SPELLING INSPECTION PERFORMED WHEN SELECTED
BARCODE
INSPECTION BARCODE INSPECTION PERFORMED WHEN SELECTED
INSPECT RUN SELECTED INSPECTION MODE

lEcDnE@m
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ﬁ MANAGE PARAMETERS FOR THE SELECTED INSPECTION
PROFILE SETTINGS .I| PROFILE (ADMIN/ MANAGER ACCOUNTS ONLY)
REPORT GENERATE INSPECTION REPORT(S)
HELP DROP-DOWN OPTIONS:
e LICENSING
HELP e GIVE FEEDBACK
e GLOBALVISION SUPPORT
e SHORTCUTS
e ABOUT
MENU DROP-DOWN OPTIONS:
e RESOLUTION
e 300, 400, 600, 800, 1200, Custom...
e ADMINISTRATION (ADMIN/ MANAGERS ONLY)
e  Settings, Audit Trail, User Manager, Reporting
Levels, Comments, Workflows, Backup, Force
MENU . . . -
review of all differences, Force inclusion of all
differences
e CHANGE PASSWORD
e LAYOUT
e PREFERENCES
e LOGOUT
MASTER/ SAMPLE
—_—
PDF OPTIONS ——
MASTER / SAMPLE TOGGLE PDF OPTIONS FOR PDF/AI FILES ON OR OFF
FILE INFORMATION eee
MASTER /SAMPLE IMAGE DETAILS
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IMAGE ADJUST BRIGHTNESS, CONTRAST, AND GAMMA OF MASTER
ADJUSTMENTS OR SAMPLE IMAGES
MASTER /SAMPLE
OCR (OPTICAL MAKE MARQUEE SELECTIONS OF NON-LIVE TEXT ON
CHARACTER SCANNED DOCUMENTS COMPATIBLE WITH SPELLING

RECOGNITION)

INSPECTION

LASSO SELECTION OPTIONS:
LASSO SELECTION e ADDTOINSPECTION
e REMOVE FROM INSPECTION
o
MEASUREMENT TOOLS OPTIONS:
MEASUREMENT e RECTANGLE
TOOLS e LINE
e REPORT
3
AMSN:\JAQI&T ALIGN SELECTED POINT ON MASTER IMAGE WITH SELECTED
POINT ON SAMPLE IMAGE
MASTER / SAMPLE
| —
REGION MODE DROP-DOWN OPTIONS:
REGION MODE . e FULL PAGE
(MASTER) s a e MARQUEE
s = e TRIM
mamum e SHAPE
CROP TO : ! AUTO-ADJUST CROP AREA WITHIN THE BOUNDS OF THE
CONTENTS 0: IMAGE
MASTER / SAMPLE Rt
RELOAD PAGE
MASTER / SAMPLE RELOAD PAGE
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'd ™\
—
—— ROTATE DROP-DOWN OPTIONS:
e ROTATE 90 CW
(X | | oromEmen
MASTER/SAMPLE . o e ARBITRARY ROTATE
as e MIRROR HORIZONTALLY
e MIRROR VERTICALLY
N
COLOR INSPECTOR DISPLAY PANTONE, RGB, CMYK, AND LAB VALUES OF
MASTER / SAMPLE SELECTED POINT
3
EEER
MARQUEE ZOOM + -
MASTER / SAMPLE - . SELECT ZOOM AREA
[ |} | |
EEEEEEN
| —
£
RESET VIEW K ’
MASTER / SAMPLE > < RESTORE IMAGE TO ORIGINAL SIZE
L —
o
SAVE VIEW MASTER
GAMPLE l SAVE IMAGE DISPLAYED IN WINDOW
S —
3
CROP -
(SAMPLE) | CROP SAMPLE IMAGE
| —
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SUPPSSJE'}?TSATED ENABLE DETECTION OF ROTATED OR NESTED SAMPLE
(SAMPLE) IMAGES
MATCH SCALE
(SAMPLE) SCALE SAMPLE IMAGE TO MASTER IMAGE DIMENSIONS
INSPECTION
o
ROTATE r‘ ROT.ATE I{I\(I)I?S_II_EEDS)O(?V-VDOWN OPTIONS:
MASTER / SAMPLE . - . ROTATE 90 Gow
e
Ny
COLOR INSPECTOR DISPLAY PANTONE, RGB, CMYK, AND LAB VALUES OF
MASTER / SAMPLE SELECTED POINT
N
SHOW THE TEXT —
MASK = SHOW WHAT WAS DETECTED AS TEXT DURING INSPECTION
(MASTER)
—
MARQUEE ZOOM
A aUES 200N SELECT ZOOM AREA
RESET VIEW K ’
MASTER | SAMPLE RESTORE VIEW TO ORIGINAL SIZE
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3
SAVE VIEW MASTER
ISAMPLE l SAVE IMAGE DISPLAYED IN WINDOW
L —
J—
+ ADJUST FLASH RATE BETWEEN MASTER AND SAMPLE:
FLASH e — o INCREASE FLASH RATE
(SAMPLE) SE—
. E] DECREASE FLASH RATE
[ ]
e —
 EEE—
SET REPEAT AS
MASTER SET SELECTED REPEAT AS MASTER IMAGE
(SAMPLE)
—
3
DISPLAY THE FOLLOWING IMAGES:
e FLASH
IMAGE TO DISPLAY e MASIER
‘SAMPLE) e SAMPLE
e DIFFERENCE
e EDGE
N
TOGGLE THE FOLLOWING SAMPLE ELEMENTS ON OR OFF:
SHOW MASK — e MASK
(SAMPLE) — e NUMBERS
e BOXES
—
DIFFERENCE REVIEW ACTIONS:
DIFFERENCE e GROUP
REVIEW ACTIONS
(SAMPLE) * ADD
e EXCLUDE
REMOVE IDENTICAL RESULTS DETECTED AS DIFFERENCES
RESYNC TOOL FROM DIFFERENCE LIST (TEXT INSPECTION)
(SAMPLE)
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PAGE SELECTION

SELECT MASTER/ SAMPLE PAGES TO BE INSPECTED:

o ALLPAGES
PAGE SELECTION e EVENPAGES
e ODDPAGES
e PAGE RANGE
RESET PAGES RESET PAGE SELECTION

SHOW PAGES / HIDE SHOW OR HIDE ALL PAGES IN MASTER OR SAMPLE FOR

PAGES EASIER NAVIGATION
TEXT TOOLS
LIVE TEXT MASTER
SHOW LIVE TEXT
/ SAMPLE

CROSS-OUT TEXT

CROSS OUT TEXT SO IT ISNOT INSPECTED
MASTER / SAMPLE

il QE [ B
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UNDERLINE TEXT

UNDERLINE TEXT SO IT IS INSPECTED

MASTER / SAMPLE
L] L]
CREATE ZONES A MATCH AND COMPARE SPECIFIC SELECTIONS OF MASTER
MASTER / SAMPLE AND SAMPLE TEXT
| § | |
CLEARALL CLEAR ALL TEXT/ SPELLING PARTIAL INSPECTION
MASTER / SAMPLE SELECTIONS
SHOW/HIDE TOGGLE DISPLAY OF MARK-UPS (UNDERLINE/ CROSS-OUTS/
MASTER / SAMPLE ZONES) ON AND OFF
CREATE NEW JOB
PREVIOUS MOVE BACK TO LAST SCREEN
NEXT MOVE TO NEXT SCREEN
CLOSE CLOSE JOB WIZARD
INSPECT PERFORM INSPECTION
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LOAD MASTER SELECT MASTER FILE FROM FILE PATH
ol Adobe
e
LOAD SELECT MASTER/ SAMPLE FILE FROM FILE PATH
MASTER/SAMPLE
ADD FROM JOB ADD MASTER FILE FROM JOB PATH VIA SCAN FOR
PATH BARCODES FEATURE
MARQUEE
SELECTION SELECT AREA ON MASTER TO INSPECT AGAINST SAMPLE
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3. Inspection Setup

The following sections describe the main icons, options, and tools users encounter as they set up their
inspection.

3.1 File Drop-Down / Menu

The File drop-down contains the following options:

FILE MENU OPTIONS

New Job Launch the Job Wizard; See Job Wizard for more details

Load Master Select and load the Master file; See Loading Files for more details
Select and load the Sampile file; See Loading Files for more

Load Sample details

The Menu E contains the following options:

MENU OPTIONS

Select the DPI value or set a custom value; See Resolution for

Resolution .
more details

Settings — Manage user log-in/ log-out settings

Audit Trail — Display audit log

User Manager — Add/ edit user accounts and licenses
Reporting Levels — Manage pre-defined levels
Comments — Manage pre-defined comments

Administration Workflows — Create and manage preset configurations for
(Administrators and | running multiple inspections using the Job Wizard; See Job
Managers Only) Wizard for more details

Backup — Export or import a database.
Force review of all differences
Force inclusion of all differences

NOTE: Please consult the Administration Guide for more
information

Change your password; Please see Change Password for more
information

Change Password

Overview — Displays Overview panel

Layout
y Details — Displays Details panel
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Image Details — Displays Image Details panel (Text Inspection)
Inspections — Displays Inspections panel
Repeats — Displays Repeats found panel

Differences — Displays Difference List (for Graphics, Text,
Spelling, and Color Inspections)

Braille — Displays Braille panel
Barcodes — Displays Barcode panel
Master Panel — Displays Master panel
Save Layout — Saves the current layout
Reset Layout — Resets the default

NOTE Layout is disabled on the Main View and enabled on the
Inspection View; More information on layout options specific to
each inspection mode is available in subsequent chapters

Preferences

Language — The Application’s default language is English
Hi-Contrast Different Image - Show differences in high contrast

Difference Highlight Color — Toggle on and set the color and
size of the mask to display on individual differences

Mask Color — Set the color of the mask, which displays over
everything excluded from the inspection on the Master or
everything that is not detected as a difference on the Sample

Automatically zoom to each difference — Zoom to each
selected difference in the Inspection View

Raster documents after zoom — Automatically raster files after
zooming in, so they appear less pixelated

Show Scanner interface — Launch the interface of the scanner
software when scanning

Color Library — Select the applicable color library, based on the
connected color-calibrated GlobalVision scanner

Default unit — Select the default Measurement Tools unit
RGB Profile — Used to display the color space in the interface
CMYK Profile — Used to display the color space in the interface

Nextlmage Profile — Used in conjunction with Color Inspection
Mode by the connected Contex scanner

GlobalVision C8 Profile — Used in conjunction with Color
Inspection Mode by the connected GlobalVision C8 scanner
Show Job interface — Launch the Job Wizard upon resetting the
interface or logging in; See Job Wizard for more details

Job Master Path — Choose the default path to find a master file in
the Job Wizard

System Paths — Choose the default paths to save the cache,
reports, and images

Logout

Log out from the Application and display the Login window; See
Logout / Exit for more information

3.1.1 Job Wizard

This section describes the basic steps to create a new job, using the Job Wizard, following a workflow.
For more information on workflows, which consist of preset configurations (including actions and profiles)
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to help run inspections more efficiently, please consult the Administration Guide. A detailed list of the
default workflows available in the Application can be found in Appendix Workflows.

The Job Wizard helps ensure all conventions within an organization are met from tester to tester and no
one deviates from set processes. Printers specifically can make use of the Job Wizard and its Scan for
Barcodes feature, which intuitively matches pre-labeled master files to barcodes on given samples.

To create a job:

e Click File > New Job. The Job Wizard displays with its default workflows.
NOTE: The Job Wizard can be set to launch automatically when logging in or resetting the
interface by ensuring the Show Job Interface in the Preferences window is checked.

Select a Workflow Screen

Click on a workflow (either a default or custom workflow created by an administrator) to continue.
The Master & Sample Selection screen appears.

Master & Sample Selection Screen
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N ™
Click either of the Scan Sample buttons, £ #— , to scan in hard-copy sample files as required

[For |
or click the Load Sample ©= icon to load digital files.

Rotate the Sample file(s) once selected if needed, by clicking the corresponding thumbnail C: at
the bottom right of the file’s thumbnail.

Use the thumbnail (on non-scanned files) to open the Layers and Separations window.

— Click the PDF Page Box drop-down list to choose between Media Box, Trim Box, or Crop
Box selections to automatically crop the file.

— Choose to enable overprint by ensuring the corresponding box is checked.

— Click the eye E icon beside the layer(s) and/ or separation(s) to toggle each on or off.
— Click OK to accept.

[ oK ] Layers and Separations

Enable overprint

Sample Layers and Separations Window

Scan in the Master file(s) as required, by clicking the Scan Master £ button, or load a digital

1k
file by clicking one of the Load Master buttons @ =

Optionally rotate the Master file(s) once it is loaded by clicking the corresponding thumbnail C: at
the bottom left of the corresponding file’s thumbnail.

The thumbnail beside it (on non-scanned files) opens the Layers and Separations window.

— Click the PDF Page Box drop-down list to choose between Media Box, Trim Box, or Crop
Box selections to automatically crop the file.

— Click the Dieline drop-down list to select a layer or separation for extraction.

— Choose to enable overprint by ensuring the corresponding box is checked.

— Click the eye ﬂ icon beside the layer(s) and/ or separation(s) to toggle each on or off.
— Click OK to accept.
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o0 Layers and Separations

Enable overprint

ity

00@@@@0@%

Master Layers and Separations Window

e Then click the Add from Job Path E button to open the Job Path window for a list of matching
master files containing the same string in their names or parent folders. Select the applicable
Master for the current inspection.

e Fillin the Lot and Product Name fields as required. Whatever text is entered appears in the
corresponding fields in the Report Options window, as a report is being generated (and then in
the corresponding fields in the PDF report itself).

RLLTUEEITTY E LB /Users/kpatel/Documents Select

Job Path Window

e Click Next to move on to the Prepare Files screen, where the die-line color can be selected
on the Master for shape extraction.
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Prepare Files Screen
e Use the Marquee Selection tool select a different region for inspection. Click it, then on the

file to select the desired region. Resize the selection by scrolling over/ clicking on its borders and
adjusting them accordingly. Click the tool again to clear the selection and start over.

e In the case of a multi-page file, selecting a different page from the drop-down list directly below
the Marquee Selection tool enables the new one to be displayed (and adjusted). Click the Next
button again to navigate to the next master file, if more than one had been loaded.

e Click to close the Job Wizard and cancel the process (at any stage).

e Click the Inspect button to load the files in the Master and Sample panels and run the
inspection. The process follows the same steps as a normal inspection at this point, with the
file(s) just loaded in the Inspection View. Consult the Graphics, Text, or Spelling Inspection
chapters for more information.

3.1.2 Loading Files

To load a file in either the Master or Sample panel and prepare it for inspection:

e Click File > Load Master or Load Sample to launch the load-file window,
— Or double-click in the Master or Sample panel on the appropriate icon,
— Oruse “drag and drop.”
Once the load-file window is launched, select the required file and click Open.
If it is a PDF or Al file, the PDF Viewer launches instead (see PDF Viewer).
NOTE: There is more information on loading files in the respective step-by-step sections of
each chapter dedicated to the individual inspection processes.

3.1.3 Resolution

To set the resolution of a master or sample file to be loaded:

Click Menu E > Resolution.

Choose between the options available (in DPI: 300, 400, 600, 800, 1200, or Custom...).

If the selected DPI of a file you are loading is different than the Desired DPI setting in the profile
being used, the following message appears:
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System DPI is set to: 350 DPI.
Change to: 300 DPI?

Cancel

e Click Yes to change the DPI to the prescribed amount or No to move ahead with the initial value.
NOTE: The Master and Sample files must be rasterized at the same DPI value. If they do not
match, a message to confirm they do not appear when you try to run the inspection.

To set a custom value in DPI:

e Click Menu E > Resolution > Custom....
e Click and enter your own value or press the arrows on either side of the box.

@ @ Resclution

Custom DPI|

Cancel

e Click OK.

3.1.4 Preferences

The following options are available in the Preferences window:
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(X=X ) Preferences

User Interface

Language English
Hi-Contrast Difference Image O

Difference Highlight Color ]

Mask Color Select

Automatically zoom to each difference [

Raster documents after zoom O

Measurement

Default unit

Color Profiles

RGB AdobeRGB1998.icc Select

CMYK USWebCoatedSWOP.icc Select

Job Settings

Show Job interface [

N VER S UM /Users/kpatel/Documents Select

System Paths

ccneratn [, -
Report Path /Users/kpatel/Documents Select
mage save path [N -

Show font substitution notifications [

Cancel

Preferences Window

Language: The Application’s default setting is English, with Chinese, Czech, French, German, Italian,
Japanese, Korean, Polish, Portuguese (Brazil), Russian, Slovenian and Spanish also available.
Hi-Contrast Difference Image: This option displays differences between the Master and Sample
images in higher contrast. For more information, see Show Difference Image.

Difference Highlight Color: When checked, this option highlights Graphics Inspection
differences in a mask of a customizable color and size. Re-inspect for the change to take effect.
Mask Color: This option lets the user set the mask color, with the ability to pick screen or custom colors.
For more information, see Show Mask.

Automatically zoom to each difference: When this option is checked, the selected difference,
barcode, or Braille region is zoomed in on instead of just highlighted in the Inspection View.
Raster documents after zoom: When this option is checked, Barcode, Text, or Spelling
Inspection files raster automatically after being zoomed, for added clarity and less pixelation.
Default unit: Choose the unit in which lines or rectangles drawn using the Measurement Tools
will appear.

RGB Profile: The RGB Profile is used to display the color space in the user interface. The default
profile is AdobeRBG1998.icc.

CMYK Profile: The CMYK Profile is used to display the color space in the user interface. The default
profile is USWebCoatedSWOP.icc.
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e GlobalVision C8 Profile: The color calibration file for the connected GlobalVision C8 scanner (to
be used in conjunction with Color Inspection Mode).

e Show Job interface: When checked, this option automatically loads the Job Wizard whenever the
Application is opened or the interface is reset.

e Job Master Path: Set the default path loaded when selecting master files on the Master &
Sample Selection screen of the Job Wizard.

e Cache Path: Set where data is stored by the Application.
Report Path: Set the location of where generated reports are saved.
Image Save Path: Set the default path when saving images.

3.2 Inspection Modes

Graphics Inspection Mode E requires the user to load the desired Sample and Master files and select
the proper area for a pixel-by-pixel inspection. For more information, see Graphics Inspection.

Text Inspection Mode compares the text in two like or unlike documents. For example, an internally
approved Microsoft® Word® document can be inspected as the Master, with a printer’s proof of the laid-
out packaging loaded as the Sample. Change settings to switch between inspecting left-to-right, right-to-
left, and Asian languages. For more information, see Text Inspection.

Spelling Inspection Mode inspects the spelling of loaded files and detects errors using 37 language
dictionaries and one English medical dictionary. For more information, see Spelling Inspection.

3.3 Master Toolbar

The toolbar at the top of the Master panel contains the following tools:

01A_ GVVT Master.pdf

Master Toolbar
3.3.1 File Name

The loaded file’s name appears in the lower half of the toolbar, with an X on the far side. To clear the
panel and load another file, simply click the X and start the file-loading process again.

3.3.2 PDF Options

If a PDF or Al file is loaded in the Master panel, the PDF Options icon can be clicked, toggling
access to a separate set of tools on or off. See PDF Viewer for more details.

3.3.3 Master File Information Panel

To display information about the Master file:

e Click File Information . The following information displays:
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File Type: pdf
Rastered DPI: 300

Image Size: 5100 x 4512 pixels

Memory Size: 65.8 MB

Master File Information Panel

— File Type: The originating file format

— Rastered DPI: The DPI at which the file was rasterized

— Image Size: The size of the image (pixels)

— Memory Size: The amount of physical memory the rasterized image uses (MB)

3.3.4 Master Image Adjustment Panel

To adjust the Master image’s brightness, contrast, and/ or gamma value:

_:dP:_
Click Image Adjustments .

Brightness

Gamma I

Image Adjustments Panel

Click the button in the center of the applicable bar and slide it to the right or left as required.

- Alternatively click on the arrows on either end of the fields or manually enter values in each.
Click Apply to make the changes. The Master image displays in the Master panel with the
adjusted brightness, contrast, and or gamma value.

Click Cancel to close the Master Image Adjustments panel.

3.3.5 Optical Character Recognition (OCR)

-
OCR stands for Optical Character Recognition. Requiring an internet connection, the tool transforms
non-live text, like one would find on a scanned document for example, to inspectable text for the purposes
of inspecting text or spelling.

NOTE: A live-text file is ideal for accurate quality control. In the absence of a live-text file, OCR can be
useful, but is unsupported by GlobalVision; False positives and/ or missed differences may result.

To take advantage of OCR when running a text or spelling inspection on files featuring non-live text, in
the Master panel:

Click the Region Mode icon and select Marquee. For more information see Region Mode.
Left-click and use the crosshairs that appear to select the desired non-live text. A red box
surrounds the selected area. Resize/ move it as necessary by clicking and dragging its borders.
Click OCR to process the text.

NOTE: To marquee additional regions, repeat the steps above, avoiding overlap.

If applicable, crop the corresponding text in the Sample panel (for Text Inspection). For more
information, see Optical Character Recognition (OCR) (on the Sample toolbar).
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Click Inspect to run the inspection. The differences display as they normally would following an
inspection. For more information, see Text Inspection or Spelling Inspection.

NOTE: If there was live text on the file, it is detected pre-inspection as well, regardless of whether
it had been cropped. However, during text inspections, only the marqueed text gets checked. In
contrast, during a spelling inspection, all live text gets verified.

80FL OZ. 177 ml)

OCR Used on a Master File in Conjunction with Spelling Inspection

3.3.6 Lasso Selection

Lasso Selection \;j allows the user to outline and select specific portions of the Master file to be
included or excluded in a graphics inspection (shapes), segment by segment.

To add a portion of the Master to be inspected, using the Lasso Selection tool:

Click the Lasso Selection icon to access its drop-down options.

Select Add to inspection.

Click on a starting point on the Master. A red dot appears.

Drag and click again to form the first segment. A yellow dot appears.

NOTE: To undo the last segment, click on the yellow dot to redrag the segment.

Repeat the process until the last segment connects to the very first point and the shape
containing the portion of the Master to be included in the inspection has been formed.

Add additional, separate portions of the Master to be included in the same inspection, if required.
The inspection, once it is run, only verifies the selected shapes.
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01A_GVVT_Master.pdf

Red Dot to Signify
Created Point;
Yellow Dot to
Signify Created

Segment that Can

Be Undone

Lasso-Selected
Shape to be Added
to Inspection

One Lasso-Selected Shape with Another in the Process of Being Selected

To remove a portion of the Master to be inspected, using the Lasso Selection:

Click the Lasso Selection icon to access its drop-down options.

Select Remove from inspection.

Click on a starting point on the Master. A red dot appears.

Drag and click again to form the first segment. A yellow dot appears.

NOTE: To undo the last segment, click on the yellow dot to redrag the segment.

e Repeat the process until the last segment connects to the very first point and the shape
containing the portion of the Master to be removed from the inspection has been formed.

e Add additional, separate portions of the Master to be removed in the same inspection, if required.

The inspection, once it is run, only verifies the portions of the Master outside the selected

shape(s).

NOTE: If a separate shape has been selected (i.e., a die line) via Region Mode or the PDF

Viewer and the lasso-selected shape(s) appear within, the die line and all of its contents,

excluding what had been lasso-selected, will be inspected.
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To remove the entire lasso selection and start again:
e Right-click on the created shape.
e Select Reset to full page from the “Context” menu that launches.
e Re-select the die line if necessary.

3.3.7 Measurement Tool

The Measurement Tools icon gives users access to both Rectangle and Line options when running
a graphics inspection. By clicking and dragging the mouse on the file after making a selection, the user
draws either a rectangle or line, with units displayed in either inches, millimeters, or pixels (see
Preferences). This allows the user to measure the size of graphic elements in the loaded file.

To measure a line:

Click the Measurement Tools icon and select Line.

Click and drag the mouse on the file in the Master panel in the desired location.
Resize it by clicking on either one of its ends and then dragging.

Move the line by clicking on any other portion of the figure and then dragging.
Right-click for the option to delete the line.

To measure a rectangle:

Click the Measurement Tools icon and select Rectangle.

Click and drag the mouse on the file in the Master panel in the desired location.
Resize it by clicking on its borders and then dragging.

Move the rectangle by clicking in its borders and then dragging

Right-click to either delete the rectangle or select Snap to line for a closer crop.

Page 35 Published 14 January 2021
By GlobalVision, Inc.



GlobalVision Mac 5.8.2 User Guide
Rev 002

oy

01A_GVVT_Master.pdf

- :
: YOUR BRAND
coraemanen  PACKAGING

FAST ACTING
SOLUTION

30 Caplets
Made in Canada
E
=TT
b aazz5 17

SALLIE 520
39.9 mm

Process

- =T b = |
Rectangle Created, Around Barcode, Using Measurement Tools

To generate a PDF report of the measurements (without inspecting the files):

Click the Measurement Tools icon and select Report. The Report Options window launches.

e Fillin the fields as required (for more information, see Generating Reports).
NOTE: The PDF Attachment option is not available for Measurement Tools reports.

e Click View or Save to generate the report, which lists each of the measurements made in inches,
millimeters, and pixels.

3.3.8 Manual Alignment

Manual Alignment preps the loaded images for a pixel-by-pixel comparison by using a selected
reference point on the Master and Sample files.

NOTE: The loaded images must have the same orientation and be approximately the same size.

Click Master Information or Sample Information to get the image size.

To use the Manual Alignment tool:

e Click Marquee Zoom |- on the Master toolbar to zoom in on an area on the Master to select
the reference point.

Left-click and move the crosshairs that appear around the desired area. A red box surrounds it.
Release the button to magnify the area and select it as the reference point.

Repeat the process in the Sample panel.
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3.3.9 Region Mode

Region Mode lets you select an area in the image to be inspected.

NOTE: The minimum cropping area is 100 x 100 pixels.
If you right-click on a layer (e.g. die line) and choose Set as shape region & hide or Use as
shape region in the integrated PDF Viewer, it automatically gets set as the Shape. Selecting the
shape is key when inspecting repeats.

To select an area in the Master image to be used in the inspection:

e Click Region Mode and select one of the options:
— Full Page: The entire page gets selected as the inspection area.
— Shape: Shape mode is used to detect a shape for repeat detection. Left-click on the shape to
be used as the inspection area. The selected shape displays in the Master panel.
NOTE: You can also create a shape for repeat detection with the Marquee tool, by creating the

shape and clicking Crop to Contents afterwards.
— Marquee: Left-click and use the crosshairs that appear to select the area to be used as the
inspection area. A red box surrounds the selected area.

04_GVVT_Master_Multipage.pdf

ScanTVS

Print Inspection

Fast & accurate inspection for
all printed components

tor systen for complecs inspection of pros's. lscels. cato s a1l

r
| HARDWARE REQUIREMENTS:

| Pt

Separations

Apply to even pag
Apply to odd pages
Clear all pages

§  Change to circle

Process

— Trim: The largest bounding area of the image is selected. A red box surrounds the area.
For marquee and trim selections, additional options exist in the “Context” menu that appears by right-
clicking:

e Choose between applying the selection to all, even, or odd pages in a multi-page file.
e Click Change to circle to replace the rectangular selection with a circular one.
e Click Clear all pages to remove the selection.
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Context Menu

3.3.10 Crop to Contents

To tighten the crop selection so that it includes only the object:

Click Region Mode | - and select Marquee.
Select an area using the crosshairs that appear by clicking and dragging. A red box surrounds the
selected area.

e Click Crop to Contents | **
selection.

3.3.11 Reload Master

. The crop selection adjusts so that it contains only the revised

To reload the Master:

e C(Click Reload Page . The image reloads in the Master panel.
3.3.12 Rotate Master

To rotate the Master 90° clockwise:

(‘\
e Click Rotate > Rotate 90 CW.

To rotate the Master 90° counter-clockwise:

(‘\
e Click Rotate > Rotate 90 CCW.

To rotate the Master 180° clockwise:

(‘\
e Click Rotate > Rotate 180.

To specify the angle to rotate the Master:

('\

e Click Rotate > Arbitrary rotate. The Master Rotation window displays.

e Insert the desired angle by typing in the prompt or clicking the arrows on either side and click OK.
NOTE: Not recommended for Text and Spelling Inspection modes.

To mirror-rotate the Master horizontally:

(‘\
e Click Rotate > Mirror Horizontally.
NOTE: Not recommended for Text and Spelling Inspection modes.

To mirror-rotate the Master vertically:
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e Click Rotate > Mirror Vertically.
NOTE: Not recommended for Text and Spelling Inspection modes.

3.3.13 Color Inspector

To display the RGB, CMYK, and LAB color-space information for a selected area in the Master image:

»
e Click the Color Inspector .

e Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB
color-space values of the point selected.

Color Inspector

Color Point Detalls

Color Inspector Window

3.3.14 Marquee Zoom

To magnify the image:

e Place the cursor in the Master panel.
e Scroll upward with the track wheel.

NOTE: On a Mac operating system, scroll downward with the track wheel if the Scroll Direction:
Natural setting is ON.

To select an area in the image to magnify:

Click Marquee Zoom L&+,
Select the area using the left button of your mouse
—  Or scroll upward with the track wheel.

NOTE: On a Mac operating system, scroll downward with the track wheel if the Scroll Direction:
Natural setting is ON.

To reduce the magnification:

e Place the cursor in the Master panel.
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e Scroll downward with the track wheel.
NOTE: On a Mac operating system, scroll upward with the track wheel if the Scroll Direction:
Natural setting is ON.

To pan:
o Left-click in the Master panel. Hold and move the mouse around the panel.

3.3.15 Reset View

To restore the image to its original size:
e Click Reset View [¥™ ),
3.3.16 Save View

To save the Master image view:

e Click Save View .

e The Save As window displays. Enter the file name in the desired location and click Save.

3.4 Sample Toolbar

The toolbar at the top of the Sample panel contains the following tools:

[ EIE CHYREFBEACIAR L

02A_GVVT_Sample.pdf

Sample Toolbar

3.4.1 PDF Options

If a PDF or Al file is loaded in the Sample panel, the PDF Options icon can be clicked, toggling
access to a separate set of tools on or off. See PDF Viewer for more details.

3.4.2 File Name

The loaded file’'s name appears in the lower half of the toolbar, with an X on the far side. To clear the
panel and load another file, simply click the X and start the file-loading process again.

3.4.3 Sample File Information Panel

To display information about the Sample file:

e Click File Information . The following information displays:

File Type: pdf
Rastered DPI: 300

Image Size: 5100 X 4512 pixels

Memory Size: 65.8 MB
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Sample File Information Panel
— File Type: The originating file format
— Rastered DPI: The DPI at which the file was rasterized

— Image Size: The size of the image (pixels)
— Memory Size: The amount of physical memory the rasterized image uses (MB)

3.4.4 Sample Image Adjustment Panel

To adjust the Sample image’s brightness, contrast, and/ or gamma value:

%
e Click Image Adjustments .

Brightness

Contrast

Gamma .

Image Adjustments Panel

e Click the button in the center of the applicable bar and slide it to the right or left to adjust the
settings as required.

e You can alternatively click on the arrows on either end of the different fields or manually enter
values in each.

o Click Apply to make the changes. The Sample image displays in the Sample panel with the
adjusted brightness, contrast, and/ or gamma value.

e Click Cancel to close the Sample Image Adjustments panel.

3.4.5 Optical Character Recognition (OCR)

fock!

OCR stands for Optical Character Recognition. Requiring an internet connection, the tool transforms
non-live text, like one would find on a scanned document for example, to inspectable text for the purposes
of inspecting text or spelling.

NOTE: A live-text file is ideal for accurate quality control. In the absence of a live-text file, OCR can be
useful, but is unsupported by GlobalVision; False positives and/ or missed differences may result.

To take advantage of OCR when running a text spelling inspection on files featuring non-live text, in the
Sample panel:

Click the Crop icon. For more information see Crop Sample.
Left-click and use the crosshairs that appear to select the desired non-live text, that corresponds
to what had been marqueed in the Master panel if applicable (for Text Inspection; For more
information, see Optical Character Recognition (OCR) (on the Master toolbar)).

e Ared box surrounds the selected area. Resize/ move it as necessary by clicking and dragging its
borders.

e Click OCR to process the text.
NOTE: To marquee additional regions, repeat the steps above, avoiding overlap.
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e Click Inspect to run the inspection. The differences display as they normally would following an
inspection. For more information, see Text Inspection or Spelling Inspection.
NOTE: If there was already live text, it is detected pre-inspection as well, regardless of whether it
had been cropped. However, during text inspections, only the marqueed text gets checked. In
contrast, during a spelling inspection, all live text gets verified.

SOFL OZ (177 mL)

OCR Used on a Sample File in Conjunction with Spelling Inspection

3.4.6 Measurement Tools

The Measurement Tools icon gives users access to both Rectangle and Line options when running
a graphics inspection. By clicking and dragging the mouse on the file after making a selection, the user
draws either a rectangle or line, with units displayed in either inches, millimeters, or pixels (see
Preferences). This allows the user to measure the size of graphic elements in the loaded file.

To measure a line:

Click the Measurement Tools icon and select Line.

Click and drag the mouse on the file in the Sample panel in the desired location.
Resize it by clicking on either one of its ends and then dragging.

Move/ tile the line by clicking on any other portion of the figure and then dragging.

— When the cursor appears as a hand, you can move the line outright.

— When the cursor appears as a vertical double-sided arrow, you can shift its angle.
e Right-click for the option to delete the line.

To measure a rectangle:

Click the Measurement Tools icon and select Rectangle.

Click and drag the mouse on the file in the Sample panel in the desired location.
Resize it by clicking on its borders and then dragging.

Move the rectangle by clicking in its borders and then dragging

Right-click to either delete the rectangle or select Snap to line for a closer crop.

Page 43 Published 14 January 2021
By GlobalVision, Inc.



GlobalVision Mac 5.8.2 User Guide
Rev 002

BlAL DOSAGE:
Package Insart for ful
cribing rformation.

SECURE =
YOUR BRAND e
PACKAGING e

SAFETY !
YOUR PF

EXP12/
LOT: 12¢

Rectangle Created, Around Barcode, Using Measurement Tools

To generate a PDF report of the measurements (without inspecting the files):

Click the Measurement Tools icon and select Report. The Report Options window launches.
Fill in the fields as required (for more information, see Generating Reports).
NOTE: The PDF Attachment option is not available for Measurement Tools reports.

e Click View or Save to generate the report, which lists each of the measurements made in inches,
millimeters, and pixels.

3.4.7 Manual Alignment

Follow the process described in Manual Alignment.

3.4.8 Crop Sample

To select an area of the Sample image to be inspected:

e Click Crop .

e Left-click and select an area using the crosshairs that appear. A red dotted line surrounds the selected area.
NOTE: The minimum cropping area is 100 X 100 pixels.

Additional options exist in the “Context” menu that appears by right-clicking:

e Choose between applying the selection to all, even, or odd pages in a multi-page file.
e Click Change to circle to replace the rectangular selection with a circular one.
o Click Clear all pages to remove the selection.

Apply to all pages
Apply to even pages

Apply to odd pages

Clear all pages

Change to circle

Context Menu
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3.4.9 Crop to Contents

To tighten the crop selection so that it includes only the object:

o Click Crop Sample .

e Left-click and select an area with the crosshairs that appear. A red dotted line surrounds it.

e Click Crop to Contents " . The crop selection adjusts to contain only the revised selection.

3.4.10 Support Rotated Repeats

To run an inspection using a sample image that contains rotated repeats of the Master:

e Click Support Rotated Repeats before running the inspection. During the inspection, the
images are compared as if there were no rotation.

3.4.11 Match Scale

Match Scale =" lets you compare images with different sizes by scaling the dimensions of the Sample’s
cropped area to match the dimensions of the Master’s cropped area.

NOTE: The minimum cropping area is 100 X 100 pixels.

To use Match Scale

e In the Master panel, click Region Mode E [J Marquee and select the crop area. Use Crop to

Contents to get a tighter crop.

e In the Sample panel, click Crop and select the crop area. Use Crop to Contents E to get
a tighter crop area.

e Click Match Scale o~ . When the inspection is run, the Sample cropped area is inspected as if it
were the same size as the Master cropped area.
NOTE: Both the Master and Sample images must be cropped before Match Scale is used.
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3.4.12 Reload Sample

To reload the sample:

e Click Reload . The image reloads in the Sample panel.
3.4.13 Rotate Sample

To rotate the Sample 90° clockwise:

(‘\
e Click Rotate > Rotate 90 CW.

To rotate the Sample 90° counter-clockwise:

(‘\
e Click Rotate > Rotate 90 CCW.

To rotate the Sample 180° clockwise:

(‘\
e Click Rotate > Rotate 180.

To specify the angle to rotate the Sample:

(‘\

e Click Rotate > Arbitrary rotate. The Sample Rotation window displays.

e Insert the desired angle by typing in the prompt or clicking the arrows on either side and click OK.
NOTE: Not recommended for Text and Spelling Inspection modes.

To mirror-rotate the Sample horizontally:

(‘\
e Click Rotate > Mirror Horizontally.
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NOTE: Not recommended for Text and Spelling Inspection modes.

To mirror-rotate the Sample vertically:

r\
e Click Rotate > Mirror Vertically.
NOTE: Not recommended for Text and Spelling Inspection modes.

3.4.14 Color Inspector

To display the RGB, CMYK, and LAB color-space information for a selected area in the Sample image:

\Q
e Click the Color Inspector .

e Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB
color-space values of the color at the point selected.
NOTE: Presently not supported on Mac,
If Color Inspection Mode is enabled, a second portion of the Color Inspector window, featuring
Pantone-related functionalities, displays too whenever the Color Inspector is selected.

[ Ns] Celor Inspector

Color Point Detalls

Color Inspector Window

3.4.15 Marquee Zoom

To magnify the image:

e Place the cursor in the Sample panel.
e Scroll upward with the track wheel.
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NOTE: On a Mac operating system, scroll downward with the track wheel if the Scroll Direction:
Natural setting is ON.

To select an area in the image to magnify:

Click Marquee Zoom !
Select the area using the left button of your mouse
—  Or scroll upward with the track wheel.

NOTE: On a Mac operating system, scroll downward with the track wheel if the Scroll Direction:
Natural setting is ON.

To reduce the magnification:

e Place the cursor in the Sample panel.

e Scroll downward with the track wheel.
NOTE: On a Mac operating system, scroll upward with the track wheel if the Scroll
Direction: Natural setting is ON.

To pan:
e Left-click in the Sample panel. Hold and move the mouse around the panel.

3.4.16 Reset View

To restore the image to its original size:

XA
e Click Reset View .
3.4.17 Save View

To save the Sample image view:

e Click Save View .

e The Save As window displays. Enter the file name in the desired location and click Save.

3.5 Page Selection Toolbar

The Master/ Sample Page Selection toolbar on the bottom of the panel contains the following tools:

Page Selection Toolbar

3.5.1 Page Navigation

To display a different page in the Master/ Sample panel before or after inspections:

e Click the left or right arrows on either side of the Page Navigation tool.
— Alternatively click on the arrow in the middle of the tool to access the Page Navigation drop-
down list and go directly to the page of your choice.
NOTE: When performing single-page inspections on multi-page files, this feature is disabled after
the inspection is run.
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3.5.2 Live Text

To highlight all inspectable text (in Text or Spelling Inspection modes) in the Master or Sample panel:

e Click on the corresponding Live Text E icon.
To remove the highlights:

e Click the icon again.
NOTE: Text that is not live (and is part of an image, for example) can still be inspected, but only
as part of a pixel-to-pixel comparison between two similarly laid-out files in Graphics Inspection.

3.5.3 Cross-out Text

To exclude text from text and spelling inspections:

Click the appropriate Cross-out Text icon (in either the Master or Sample panel).

Click and drag the crosshairs icon that appears as the cursor over the text to be excluded in
either the Master or Sample panel.

NOTE: Multiple selections can be made.

To apply a cross-out to different portions of a multi-page file:

e Right-click on the crossed-out text.

e In the “Context” menu that appears, select to apply the cross-out to all pages, odd pages, even
pages, or identical text elsewhere in the file.
NOTE: Clear removes the currently selected crossed-out text. Clear All removes all cross-outs.

v Apply to this page
Apply to all pages
Apply to odd pages

Apply to even pages

Cross out identical text
Clear
Clear All

Context Menu

To cancel out underlined text (see Underline Text) using Cross-out Text:
e Click on Cross-out Text.
e Click and drag the crosshairs icon that appears as the cursor over the underlined text.
e The underlines are removed.
NOTE: Cross-out Text and Underline Text cannot otherwise be applied together in the same
file (unless it is to cancel the other one out).
3.5.4 Underline Text

To specifically include text in text and spelling inspections (and exclude all other text):

Click the appropriate Underline Text icon (in either the Master or Sample panel).

Click and drag the crosshairs icon that appears as the cursor over the text to be included in either
the Master or Sample panel.

NOTE: Multiple selections can be made.

To apply an underline to different portions of a multi-page file:
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Right-click on the underlined text.

In the “Context” menu that appears, select to apply the underline to all pages, odd pages, even
pages, or identical text elsewhere in the file.

NOTE: Clear removes the currently selected underlined text. Clear All removes all underlines.

To cancel out crossed-out text (see Cross-out Text) using Underline Text:

Click on Underline Text.

Click and drag the crosshairs icon that appears as the cursor over the crossed-out text.

The cross-outs are removed.

NOTE: Cross-out Text and Underline Text cannot otherwise be applied together in the same
file (unless it is to cancel the other one out).

3.5.5 Create Zones

Create Zones can be used to specifically include sections of a given document in text inspections
(excluding all other text) and compare them directly to the corresponding portions in the other panel. This
comes in handy when inspecting tables, by selecting different columns/ rows individually in each of the
Master and Sample panels.

To start creating a zone:

Click the Create Zones . icon below the Master or Sample panel.

Click and drag the crosshairs icon that appears as the cursor over the text to be included. The
text is highlighted and an ID is assigned.

Highlight the corresponding text in the Sample. A corresponding ID is assigned.

NOTE: The Zoning sub-panel pops up in the Sample panel, as a guide as to which matches are
available to be selected. Clicking on a match zooms in to that selection on the Sample, so you
can highlight it.

Create new zones by clicking and dragging separate portions of text in each panel and repeating
the overall process, one at time.

(XX GlobalVision

03.GVVT_Master. POFinspection.pdf x i 04 GVVT_Sample_PDFinspection.pd

DocuProof DocuProof
ocuProo
DIGITAL TEXT COMPARATOR DIGITAL TEXT COMPARATOR

“The DocuProcrDiga Text Comparatr s The DocuProof Digial Tex Comparatr s a
i 9 Engli, Frerch, Sparish alan, |SPELL CHECKER 8 TEXT
proofeadig ERGUONCINSIESION 012 Gorpess o saparese PROCESSORS

o
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Zone #1 Selected in Master and Zoning (Sample) Panels

To add to a zone:

e Right-click on a zone that has already been selected, prompting the “Context” menu to appear.

Add

Clear
Clear All
Context Menu

Select Add.

Click and drag the cursor over a new portion of text.

The same number designation of the original zone appears at the top of the new selection.
Repeat the process in the other panel if necessary.

To clear a zone:

e Right-click on a zone that has already been selected, prompting the “Context” menu to appear.
e Select Clear to delete a zone and its counterpart in the opposite panel.

NOTE: Clear also deletes the original zone if you had right-clicked on an added portion.
e Select Clear All to delete all zones in both panels.

3.5.6 Show / Hide

To toggle the appearance of all underlines, cross-outs, or zones on or off in a master or sample file, either
before an inspection or after:

e Click the Show/Hide icon.

ssssssssssss

||||||

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

| Text Com paratorrl's a[ext (Com paraterrlls a
pol which automates 5 which automates
bnic inspection of 2 ic inspection of 2
eight seconds or seconds on average
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Show/Hide Toggled On in Master Panel, Toggled Off in Sample Panel

3.5.7 Clear All

To clear all underlines, cross-outs, or zones in a master or sample file:
e Click the Clear All icon. A message appears, asking if you want to continue.
e Click Yes.
3.5.8 Page Selection

Click the Page Selection icon for the option to include or exclude pages from a multi-page document
when running an inspection. This launches the Select Pages window. When clicking the icon in the
Master panel, the Select Master Pages window pops up. When clicking the icon in the Sample panel, the
Select Sample Pages window pops up instead.

[ JoN | Select Master Pages

©Q Include @ All Pages

& Exclude @ Even Pages
® Odd Pages
© Page Range

1-4|

Apply to Master Copy to Sample

Select Master Pages Window
To include/ exclude different pages in a master or sample file before running an inspection:

Click Include or Exclude on the left side of the window.
Click either All Pages, Even Pages, or Odd Pages, or enter a custom range on the right side.
Select Apply to Master/ Apply to Sample, depending on the panel in which the Page Selection
icon was first clicked, to finalize the page range.

e Select Copy to Sample / Copy to Master to apply the same range to the other panel.
NOTE: Copy to Sample / Copy to Master can only be used when the number of pages is the
same in the Master and Sample.

To reset the pages and negate your selection:

e Click the Reset Pages E icon to the left of the Page Selection icon.

3.5.9 Show Pages

The Show Pages / Hide Pages icon shows/ hides an extra panel displaying all the pages loaded in the

f

Master or Sample panel. When the panel is hidden, an up arrow . appears. Once the icon has been

clicked and the panel appears, displaying the different pages, a down arrow appears instead.
NOTE: The icon is disabled once an inspection is run.
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4 |Page

Page 1 Page 2 Page 4

Show Pages Panel

To display a different page in the Master or Sample panel:
e Click on the page of your choice in the Show Pages panel.
To scroll through the loaded pages in the Show Pages panel:

e Move the mouse over the scroll bar at the bottom of the panel.
e Scroll the track wheel up or down or left-click the mouse and move it in the desired direction.

— Alternatively, right-click on the scroll bar and choose between the following options:
o Scroll here

o Left edge or Right edge
o Page left or Page right
o Scroll left or Scroll right

To exclude a page from the inspection:

e Right-click on a page in the panel to reveal the Exclude Page option.
e Click it to cross the page out and exclude it from the inspection.
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To re-include excluded page(s):

e Right-click a page and unselect the Exclude Page option that appears.

e Alternatively click the Reset Pages E icon to reset all pages.
3.6 PDF Viewer

The integrated PDF Viewer launches when you load a PDF or Al file. It consists of various panels and

can be toggled on/ off and hidden from view when clicking the PDF Options button on the far left of
either the Master or Sample toolbar.
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3.6.1 PDF Viewer Options Panel

3.6.1.1 Options

Options

Enable overprint
[ Follc g page for region

PDF Page Boxes:

+ Media Box
Trim Box
Crop Box

Options Panel

To select an option, click the checkbox beside it or select one of its drop-down options:

e Enable overprint: Provides an on-screen simulation that approximates how blending and
overprinting appears in color-separated output. The initial default is set to checked, while the
user’s selection acts as the new default for subsequent inspections.
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e Following page for region: When a file has multiple pages, you have the option to apply the die
line on the next page. This would be used if the die line is on the next page relative to the artwork
(as opposed to the same page, as is the case with some files).

e PDF Page Boxes: Select the appropriate page box for shape selection:
- Media Box: Defaults to Media Box
- Trim Box: Defaults to Trim Box (to be used if your file is print-ready)
- Crop Box: Defaults to Crop Box

3.6.1.2 Layers

Layers

@ Dieline

Layers Panel

The Layers panel displays a list of the layers present in the PDF file.
To hide a layer:

e Click the eye icon E The icon grays out and the layer becomes hidden in the image.
To unhide a hidden layer:

e Click the eye icon E The icon returns to its default color and the layer re-appears in the
image.

3.6.1.3 Separations

Separations

@ [l PANTONE 109 C

A4 PAMTONE Orange 021C
@ [l Die Line

© [l Varnish

Separations Panel

The Separations panel displays the color separations present in the PDF file.
To hide a separation:
e Click the eye icon E The icon grays out and the separation becomes hidden in the image.

To unhide a separation:

e Click the eye icon ﬂ The icon returns to its default color and the separation re-appears.

3.6.1.4 Layers and Separations Sub-Menu
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Set as shape region & hide

Use as shape region

Shape by default
Hide by default

To select a sub-menu option:

e Right-click on a layer or separation to display the sub-menu.
e Click to select an option:

NOTE:

3.6.1.5

Set as shape region & hide: The layer or separation is detected as a shape and hidden
when the image is loaded into the Master/ Sample panel (with the shape outlined).

NOTE: Only one layer or separation can be used for shape extraction at a time. The selected
layer or separation is underlined in its corresponding panel in the integrated PDF Viewer.
Use as shape region: The layer or separation is detected as a shape. The image loads in
the Master/ Sample panel with the shape outlined. The layer or separation is not hidden.
NOTE: Only one layer or separation can be used for shape extraction at once. The selected
layer or separation is underlined in its corresponding panel in the integrated PDF Viewer.
Add to shape library: The layer or separation by the same name is detected as a shape by

default. A yellow folder icon “ displays to the left of the selected layer to indicate it has
been added to the Library. Right-click to uncheck the Add to shape library option.

Adding to a shape library takes effect at the next load. For the shape to be set, reload the file.
Hide by default: If you select this option, the selected layer/ separation always stays hidden.

The eye icon grays out and a folder icon“ displays. Right-click to uncheck the option.
NOTE: Hide by default takes effect at the next load, including for the file currently loaded. For
the layer or separation to be hidden on the file currently loaded, reload the file.

Process

Process

< Ml Cyan
@ [ Magenta

@ W velow
© Black

Process Panel

The Process panel displays the process colors that are present in the PDF image.

To hide a process color:

e Click the eye icon ﬂ The icon grays out and the process color becomes hidden in the image.

To unhide a process color:

e Click the eye icon E The icon returns to its default color and the process color re-appears.
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4. Inspection Process
The chapter describes the basic steps involved with running an inspection.

4.1 Inspection View

Once an inspection is run, the Inspection View loads.

NOTE: On a Mac, the Repeats found panel (in Graphics Inspection) displays on the left side.

Repeats
Found
Panel

Inspections
Panel

LR 1 L]
i, SECURE
Difference
List

e i
<o |,

Difference
Details/
Levels and
Comments
Panel

Overview
Panel

Inspection View

4.2 Performing Inspections

The inspection process lets users review the detected differences when comparing two files, review
measurements, review detected spelling mistakes, with both single inspection and multi-inspection
options available. Furthermore, the color-space information at individual points can be compared between
files. The following sections describe the basic steps to follow when running an inspection. For more
detailed steps describing each specific inspection process, see Graphics Inspection, Text Inspection,
Spelling Inspection.

4.2.1 Single Inspection

To perform a single inspection:

Load the Master/ Sample files you want to inspect in the Master/ Sample panels respectively.
Make sure the area you would like to inspect is selected before proceeding.
Select the appropriate mode for the inspection you would like to perform:

— Graphics Inspection E
T=
— Text Inspection
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— Spelling Inspection
Select the appropriate action and then profile from the Action and Profile drop-down menus
respectively.

Click

4.2.2 Multiple Inspections

To run multiple inspections in the different inspection modes:

4.3

Load the files you want to inspect in the Master and/ or Sample panels respectively.

Make sure the region you would like to inspect is selected before proceeding.

Select the inspection modes you would like to perform one by one, clicking the check boxes in
their icons as you do:

— Graphics Inspection
TE]
— Text Inspection

— Spelling Inspection M

For each inspection mode, select the appropriate action and then profile from the Action and
Profile drop-down menus.

NOTE: The Application performs the Graphics, Text, and Spelling inspections based on the last

action and profile selected in each mode.

Click the Inspect m icon.

Canceling / Changing the Inspection

4.3.1 Reset

To clear the Master/ Sample images and inspection results from the Master/ Sample panels:

e Click Reset .

The following message appears, asking if you want to continue:

Inspections and Documents will be cleared. Click Yes
to continue.
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e Click Yes to clear the Master/ Sample images and the inspection results (if applicable) from the

Master/ Sample panels.
e Click No to retain the files in the Main View.

4.3.2 Back/ Forward

To retain inspection results and return to the Main View, so you can run additional inspections:

e Click Back .

To return to the Inspection View:

e Click the same button, which has become Forward .

4.3.3 Cancel Inspection

To cancel an inspection:

e Click Cancel Inspection on the pop-up Progress window as the inspection is running.

| JON | Progress

Inspecting

C

Checking for repeats...

Cancel Inspection

Progress Window

4.4 Reviewing and Proofing

4.4.1 Navigating Differences

e Use the track wheel or Master/ Sample Marquee Zoom £ in the Inspection View to zoom in or

out of the image.
Hold the left mouse button and move it around to pan the image.
To review multiple pages, navigate through them at the bottom left of the Inspection View.

Page Navigation
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Select a specific difference (where applicable) and highlight it in the Inspection View by clicking
its corresponding number in the Difference List in your layout. The difference gets highlighted in
the Inspection View.

NOTE: Ensure Automatically zoom to each difference is checked in the Preferences window
(under Menu) to zoom in to individual differences once you select them as well.

Review differences in repeats (where applicable) by clicking the corresponding repeat in the
Repeats found panel in your layout. That repeat’s individual differences loaded in the Difference
List.

For more information on your layout and the different panels applicable to the inspection being
run, see the “Layouts” sub-section in the corresponding, subsequent chapter.

Reviewing Differences

Select a difference (where applicable) by clicking it in the Difference List in your layout to assign
levels (i.e., Critical, Major, Minor) and comments to it. For more information on assigning levels
and comments to differences, see the corresponding section on the Difference List and
Difference Details panel in the Graphics Inspection, Text Inspection, Spelling Inspection, or
Color Inspection chapters.

Navigate to the next difference by pressing the DOWN ARROW | key, pressing the F11 key, or
by clicking Include in the Difference Details panel. Pressing the F12 key or clicking Exclude
also navigates to the next difference but excludes the initial one from the report.

Navigate to the previous difference by pressing the UP ARROW 1 key or clicking it.
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The following section describes the steps involved with generating a report, which is the culmination of

the inspection process.

NOTE: Multiple inspections can be combined into one report. Whatever inspections have been run and
have not been specifically excluded appear in the generated PDF.

To generate a report:

e C(Click Report . The Report Options window displays.

Product ID

Report Options

Status  |Select Status

Inspected By

Include:

[ signature field

Levels 1o Inciude

[] Master

[ Only pages/repeats with differences Thumbnails

Report Path

Report File Name

PDF Attachment

Comments

[Users/kpatel/Documents Select
Report.pdf
I scct

Cancel

Report Options Window

e Fill in the Report Options window where applicable.

NOTE: The Inspected By field is pre-populated with the user name and no modifications are
allowed. All other fields, except Status, which must be modified from the Select Status default,

are optional.
REPORT OPTIONS ACTION
Product ID Enter the Product ID; The Report File Name below

automatically reflects the entered value

Product Name

Enter the Product Name

Inspected By

No action required; The field is automatically populated
with the name of the user who performed the inspection

Status

Select Pass/ Fail (required)

Lot

Enter the Lot Number; The Report File Name below
automatically reflects the entered value

Levels to include

Only differences with levels matching selection(s) are
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included in report; Does not appear if “Force inclusion of
all differences” has been selected by an administrator

Only pages/repeats with Check to include only the pages or the repeats that have
differences at least one difference

Master Check to include the Master image (where applicable)
Signature field Check to include the signature field (Performed By,

Reviewed By fields) in the report; Automatically included
when the licensed option to Enable Electronic
Signatures in the Settings window has been selected by
an administrator

Thumbnails Check to include thumbnails of each difference
(Graphics, Text, and Spelling Inspection only)

Report Path Select where the report gets saved

Report File Name Set the name of the report to be saved

PDF Attachment Browse for and attach a PDF to the report

Comments Enter general comments to be included in the report

e Click View or Save. If a status has not been selected, the following message displays:

Please set the inspection status to Pass or
Fail.

Cancel

e Click Pass or Fail to set the inspection status. Click Cancel to return to the Report Options
window.
e If the licensed option to Enable Electronic Signatures has been checked by your administrator

in the Settings window (via the Menu E), the Electronic Signature window displays.

Page 63 Published 14 January 2021
By GlobalVision, Inc.



GlobalVision Mac 5.8.2 User Guide
Rev 002

| JON | Electronic Signature

Signature

user name [
rassword |

Cancel

Electronic Signature Window

Fill in the User Name and Password fields (as you would to log in) and click Sign. Click Cancel
to return to the Report Options window.

If Save had been selected in the Report Options window, the report is saved in the selected (or
default) report path.

If View had been selected, the report saves in the selected (or default) report path and displays in
the default PDF reader. All inspections are included in the report (if applicable).
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6. Graphics Inspection

Graphics Inspection Mode lets you compare single or multi-page master and sample files pixel by pixel
and detect differences in text and artwork. Differences are highlighted and levels and comments on each
can be added for more of an in-depth proofing and reviewing process. The following sections describe the
inspection process.

6.1 Step-by-Step

This section describes the steps to follow when running a graphics inspection.

6.1.1 Load Electronic Files

For Single Page Inspections:

Click File Menu > Load Master or click in the Master panel to launch the load-file window.

— You can also load a file by using “drag and drop.”

Select the Master file from the load-file window and click Open.

If the Master is a BMP, PNG, TIF, TIFF, JPG, or LEN file, the image loads in the Master panel.

If the Master is a PDF or Al file:

— Prepare the Master image, if required, using integrated PDF Viewer tools to hide layers and/
or separations, use shapes as regions for repeat detection, etc. See PDF Viewer for more
details.

Click File Menu > Load Sample or click in the Sample panel to start repeating the process
to load the Sample file.

For Multi-Page Inspections:

Click File Menu > Load Master or click in the Master panel to launch the load-file window.

— You can also load a file by using “drag and drop.”

Select the Master file from the load-file window and click Open.

The first page of the Master image loads in the Master panel. The others can be selected from

the Page Navigation drop-down list at the bottom of the panel.

If the Master is a PDF or Al file:

— Prepare the Master image, if required, using PDF Viewer tools to hide die lines, layers
and/ or separations, use shapes as regions for repeat detection, etc. See PDF Viewer for
more details.

Click File Menu > Load Sample or click in the Sample panel to start repeating the process
to load the Sample file(s).
Ensure the Proper Inspection Area is selected.

Use master/ sample tools to crop, rotate the image, etc. Make sure the appropriate Region Mode
is selected. See Region Mode for more information.

Select the Graphics Inspection Mode icon E

Select the Action.
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v/ Single Page
All Pages

All Pages Unsorted
Single to Many
Many to Many

Action Drop-Down Menu

To compare a single master page to a single sample page or press sheet:
e Set Action > Single Page.
To compare all master pages or files to all sample pages or files:

e Set Action > All Pages.
NOTE: The pages must be in order to allow for comparison. Repeats per page are not supported.

To compare all master pages or files to all sample pages or files when they are in a different order:

e Set Action > All Pages Unsorted.
NOTE: Repeats per page are not supported.

To compare a single-page master file to a multi-page sample file with repeats:

e Set Action > Single to Many.
NOTE: This is useful for comparing a batch of press sheets against the Master or checking
the number of instances the Master appears on the Sample side.

To compare unsorted multi-page master files to unsorted multi-page sample files with repeats:

e Set Action > Many to Many.
NOTE: This is useful for comparing batches and for ganged sheets. This action requires the
most memory.

To compare two individual full pages/ press sheets against one another without looking for repeats to
speed up the inspection process:

e Set Action > One to One.
e Select the Profile.

Click Profile.

Select the profile that best suits your inspection needs to detect the required differences from the
drop-down menu. Alternative profiles may be created. See the Administration Guide for more
details.

+/ Digital
Digital to Scan

Digital to Scan modified
Len

Proof

Scan to Scan

Graphics Inspection Profiles
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The following default profiles are installed with the system:
PROFILE FILE TYPES (MASTER AND SAMPLE)

Digital to Scan Electronic original artwork and a scanned image

Digital Electronic original artwork and a revised copy

Len Run Length Encoding bitmap file and a Run Length Encoding bitmap file

Proof Electronic original artwork and a digital proof

Scan to Scan Scanned image and a scanned image

6.1.2 Run the Inspection

e Click m The images are inspected and the differences display in the Inspection View
Sample panel.

A @ CH /28 X4

02A GVVT_sample.pdf

|| GlobalVision

Inspection View Sample Panel
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6.1.3 View the Results

To view the inspected image or file:

Use the track wheel to zoom in or out of the Master or Sample panels.

Hold the left mouse button and move it around to pan the image.

To review multiple pages, navigate through them using the Page Navigation drop-down list at
the bottom left of either panel.

Page Navigation

To view a repeat:

o Click the desired repeat in the Repeats found panel in your layout. Repeats with differences are
highlighted in red. Repeats without differences are highlighted in green. For more information on
layouts and the different panels available, see Layouts.

There are several ways to view differences.

e Click the Image to display drop-down menu.
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v Flash

Master
Sample
Difference
Edge

e Click Flash to alternately display the differences between the Master and Sample images. To
change the rate at which the images alternate:

— Click Increase Flash Rate to increase the rate.

— Click Decrease Flash Rate [5 to decrease the rate.
Click Master to display the Master image.

Click Sample to display the Sample image.

Click Difference to display the Difference image.

Click Edge to display the Edge Difference image.

6.1.4 Review and Proof the Differences

To select a difference:

e Click on the difference in the Difference List. It gets highlighted in the Inspection View and
outlined in red in the Overview panel. A checkmark gets added in the Difference List to indicate
it has been reviewed.

Difference in
Overview Panel

cm/s8 X

Difference Highlightedin Inspection View

Check Mark
Added in
Difference

List

Insert for Fc

formation.

Difference #3 Selected

There are three ways to assign a level to a difference:

e Select the difference in the Difference List. Click in the Level column beside the difference in the
same panel and select the level. The color-coded level displays to the right of the difference.
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Select the difference in the Difference List. Click the Level drop-down list in the Difference
Details panel and select the level. The color-coded level displays to the right of the difference in
the Difference List.

NOTE: Hot keys (F1 — F5) may be applied to assign levels. Select the difference and click the
appropriate “F” key (see below):

KEY FUNCTION
F1 Reporting level - Critical
F2 Reporting level - Major
F3 Reporting level - Minor
F4 Reporting level - Ignore
F5 Reporting level — None

* @ Differences found: 16

Type Level
L Difference List

Change

Change

Change I\L/Ie|r\1/§|r
Change Assigned

Change Minor
Change
Change

Change

Difference Details

Repeat 2 Difference 3

Comments | En

Level . Minor
Naone

Level Drop- Critical

Down List T

. Mirar

Ignore

Level Assigned Using Difference Details Panel

Alternatively, double-click the difference in the Inspection View. The Difference window displays.
Click the Level drop-down list in the Difference window and select the level. Click X to close the
Difference window. The color-coded level displays to the right of the difference in the Difference
List.
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Level Assigned Using Difference Window

To assign a level to multiple differences:

e Hold down the CTRL key while selecting the differences.

e Click the Level column in the Difference List or the Level drop-down list in the Difference
Details panel, and select the level.
NOTE: On a Mac operating system, to assign a level to multiple differences, hold down the
COMMAND and SHIFT keys while selecting the differences.

To remove a level assignment:
e Select None as the difference’s level. The level no longer displays in the Difference List.
There are two ways to assign a pre-defined comment to a difference:

e Select the difference in the Difference List. Click the Comments drop-list in the Difference
Details panel and select the comment. The comment displays in the Comments text box. A
sticky-Note icon displays in the Difference List to the right of the difference.
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x & Differences found: 16
ID Type Level
2 Change “

Change v

Change &
5 Change <
6 Change Comment “Color” Assigned

Change to Difference #1

Change

Change
Change

Change

2 Change

Change

Change

B spooon

Color
Registration
Text
Image
Barcode
Braille
Comments |Color

Comments
Drop-Down List (e gnots

Exclude Include

Pre-Defined Comment Assigned to Difference #2

Alternatively, double-click the difference in the Inspection View. The Difference window displays.
Click the Comments drop-down list in the Difference window and select the comment. Click X to
close the window. The comment displays in the Comments text box. A sticky-Note icon displays
in the Difference List to the right of the difference.

To assign a comment to multiple differences:

Hold down the CTRL key while selecting the differences, click the Comments drop-down list, and
select the comment.

NOTE: On a Mac operating system, to assign a comment to multiple differences, hold down the
COMMAND and SHIFT keys while selecting the differences, click the Comments drop-down box,
and select the comment.

There are two ways to assign a customized comment to a difference:

Select the difference in the Difference List, click the Comments drop-down list in the Difference
Details panel, and type in the comment. A sticky-Note icon displays in the Difference List to the
right of the difference.

Alternatively, double-click the difference in the Inspection View. The Difference window displays.
Click in the Comments text box in the Difference window and type in the comment. Click X to
close the Difference window. The comment displays in the Comments text box. A sticky-Note icon
displays in the Difference List to the right of the difference.

To delete a comment from a difference:

Click in the Comments drop-down box in the Difference Details panel and select the blank
entry.

To include the selected difference in the report:

Press F11
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— Or click Include in the Difference Details panel

To exclude the selected difference in the report:
e See Exclude Differences.

To add a difference:

e See Add Differences.

To group differences:

e See Group Differences.

6.1.5 Include Inspections in Report

The Application lets you rename inspections and/ or exclude them from the report. This option is available
under the Inspections panel.

To rename the inspection:

Right-click on the inspection name in the Inspections panel.
Click Rename.

Enter the desired name and click OK.

The new name displays in the Inspections panel.

To exclude the inspection from the report:

e Right-click on the inspection name in the Inspections panel.
e Click Exclude from report.
e The inspection name gets crossed out in the Inspections panel.

X & Inspections

2 Graphics Single Page
3 Graphics Single Page
4 Graphics Single Page

e The inspection is not included in the next generated report.
NOTE: For more information on layouts and the panels available to you, see Layouts.

6.1.6 Generate the Report

e C(Click the Report icon.
e See Generating Reports for step-by-step instructions.

6.1.7 Retain Inspection Results and Run a New inspection

e Click Back . The Main View displays with the Master and Sample images loaded.
e To load new files, follow the steps above.
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e If required, prepare the Master/ Sample images for inspection using Master/ Sample tools to crop,
rotate the image, etc. Make sure the appropriate region is selected. See Region Mode.

e Click m The images are inspected and the differences display in the Inspection View
Sample panel. Each subsequent retained inspection gets listed in the Inspections panel.

6.1.8 Clear Inspection Results and Run a New Inspection

e Click Reset . The following message displays:

Inspections and Documents will be cleared. Click Yes
to continue.

e Click Yes to clear the inspection results and documents. The Main View displays with the profile
on the title bar.

6.2 Master Toolbar

The Master toolbar appears at the top of the Master panel following an inspection:

Cr/7rE X 4

Master Graphics Inspection Toolbar

6.2.1 Rotate

To rotate the Master image:

e Click Rotate .

e Select Rotate 90 CW or Rotate 90 CCW.

6.2.2 Color Inspector

To display the RGB, CMYK, and LAB color-space information for a selected area in the Master image:

\Q
e Click the Color Inspector .
e Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB
color-space values of the color at the point selected.
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NOTE: Presently not supported on Mac.

If Color Inspection Mode is enabled, a second portion of the Color Inspector window, featuring
Pantone-related functionalities, displays too whenever the Color Inspector is selected.

Color Inspector Window

6.2.3 Show the Text Mask

To see what was detected as text during the inspection:

e Click Show the text mask .

NOTE: The masked content represents all that which is affected by the parameters under the
selected inspection profile’s Text tab. See Profiles for a list of all applicable settings.

Show the Text Mask

6.2.4 Marquee Zoom

To select an area in the image to magnify:
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e Click Marquee Zoom !
e Select the area using the crosshairs that appear and left button of your mouse
—  Or scroll upward with the track wheel.

To reduce the magnification:

e Place the cursor in the Master panel.
e Scroll downward with the track wheel.

To pan:
e Left-click in the Master panel. Hold and move the mouse around the panel.

6.2.5 Reset View

To restore the image to its original size:

A
e Click Reset View .
6.2.6 Save View

To save an image to a file:

e Click Save View . The Save As window displays with the file type .tif as the default.

e Select the desired file type and storage location and click Save.

6.3 Sample Toolbar

The Sample toolbar appears at the top of the Sample panel following an inspection:

Rev 002

MGV o E 2 X

Sample Graphics Inspection Toolbar

6.3.1 Increase Flash Rate
To change the rate at which the differences between the Master and Sample images alternate:

e Click Increase Flash Rate to increase the rate.

e Click Decrease Flash Rate E to decrease the rate.
6.3.2 Image to Display

The Image to Display drop-down list lets the user toggle between different images in the Inspection

View Sample panel. The default is the Flash image.

v Flash
Master

Sample

Difference
Edge
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Image to Display Drop-Down Menu
6.3.2.1 Show Master Image

To display only the Master image in the Inspection View Sample panel:

e Click the Image to Display icon.
e Select Master from the drop-down list.

Show
Master
Image

Show Master Image
6.3.2.2 Show Sample Image

To display only the Sample image in the Inspection View Sample panel:

e Click the Image to Display icon.
e Select Sample from the drop-down list.

CH/faxX4
Show

Sample
Image
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Show Sample Image

6.3.2.3 Show Difference Image

To display only the differences in the Inspection View Sample panel:

e Click the Image to Display icon.
e Select Difference from the drop-down list.

CH /28 X4

®

Show
Difference
Image

Show Difference Image

To display the difference image in a higher contrast (i.e., each difference in yellow against a blue
background), surrounded by a red box:

Click File Menu U Preferences to open the Preferences window.

Click the Hi-Contrast Difference Image checkbox under User Interface.

Click OK to close the Preferences window.

NOTE: You need to re-run the inspection for the High-Contrast Difference Image change to
take effect.
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High-Contrast Difference Image

Difference #3 — with High Contrast Difference #3 — Without High Contrast

6.3.2.4 Show Edge Image

To display only the edge differences in the Inspection View:

e Click the Image to Display icon.
e Select Edge from the drop-down list. Each difference displays against a gray background,
surrounded by a red box.
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Show Edge
Image

Show Edge Image
6.3.3 Show Mask

6.3.3.1 Show Mask
The Show Mask drop-down menu lets the user toggle the mask and difference IDs (numbers and/ or

boxes) on or off.

J  Mask

 Mumbars (ALT + H)

. Boxes (ALT + H)

Show Mask Drop-Down Menu

Show Mask toggles the mask on or off to isolate the differences or show them in context of the image.
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Show Mask Off

Show Mask On
To toggle the mask on or off:

e Click the Show Mask @ icon.
e Select Mask from the drop-down list.

To change the mask color:

e Click File Menu 00 Preferences. The Preferences window displays.
Click Select beside Mask Color. The Mask Color window displays.

Mask Color

Pick Screen Color

Red:

Green:

Custom colors

Blue:

EEEEEEEN
EEEEEEEN Alpha channel:

Add to Custom Colors HTML:  ERlsclact

Mask Color Window

o Select the desired color and click OK to close the Mask Color window.
o Click OK to close the Preferences window.

NOTE: You need to return to re-run the inspection for the new mask color to take effect.
6.3.3.2 Show Boxes
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Boxes is found under the Show Mask icon and lets the user toggle between displaying/ not
displaying boxes around the differences.

full

Show Boxes On Show Boxes Off

To toggle the difference boxes on and off:

e Click the Show Mask @ icon.
e Select Boxes from the drop-down list.

6.3.3.4 Show Numbers

Numbers is found under the Show Mask icon and lets the user toggle between displaying/ not
displaying difference IDs next to the differences.

Show Numbers On (w/ Show Boxes Off) Show Numbers Off

To toggle the difference numbers on and off:

e Click the Show Mask list.

e Select Numbers from the drop-down menu.

6.3.4 Rotate

To rotate the Sample image:

e Click Rotate .

e Select Rotate 90 CW or Rotate 90 CCW.

6.3.5 Difference Review Actions
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The Difference Review Actions drop-down list lets the user manage the differences detected, by
grouping/ excluding them or adding new ones.

6.3.5.1 Group Differences

e Click the Difference Review Actions icon and then Group.

e Use the crosshairs that appear to select the differences to be grouped by left-clicking and drawing
a red box around them. A difference ID gets assigned to the group, which is added to the
Difference List as a change. The difference count also adjusts accordingly.

NOTE: The new difference is automatically included in the report. To exclude it, click Exclude.

e Forrepeats, once you select to group the differences, the following message displays: “Apply to
all repeats?” Click Yes to add the grouping to all repeats. Click No to add the grouping to the
selected repeat only.

Differences #2 and #3 Before Grouping After Grouping - Difference #17 Created

6.3.5.2 Add Differences

To add a difference to the inspection results:

e Click the Difference Review Actions icon and then Add.

e Use the crosshairs that appear to select the area in the Inspection View to be added as a
difference by left-clicking and drawing a red box around it. The selected area gets added as the
final difference in the Difference List.

NOTE: The added difference is automatically included in the report. To exclude it, click Exclude.

e Forrepeats, once you select the area to be added as a difference, a message displays: “Apply to
all repeats?” Click Yes to add the difference to all repeats. Click No to add the difference to the
selected repeat only.
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6.3.5.3 Exclude Differences

To exclude a reviewed and included difference:

o C(Click the Difference Review Actions icon and then Exclude.

e Use the crosshairs that appear to select the difference in the Inspection View Sample panel to be
excluded by left-clicking and drawing a red box around it. The difference gets crossed out in the
Difference List and excluded in the report.

NOTE: You can alternatively select the difference in the Difference List and click Exclude. However, an
administrator can configure the Application to force the inclusion of all differences, in which case
the Exclude and Include options do not display in the Difference Details panel.

e For repeats, once you select the difference to be excluded as a difference, a message displays:

“Apply to all repeats?” Click Yes to exclude the difference in all repeats. Click No to exclude the
difference on the selected repeat only.

X @ Difference Details

Repeat 2 Difference 1

Comments

Level Include and
Exclude
Options
Removed

Difference Details Panel -
Include and Exclude Options Removed

6.3.6 Color Inspector

To display the RGB, CMYK, and LAB color-space information for a selected area in the Sample image:

N
e Click the Color Inspector .

e C(Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB
color-space values of the color at the point selected.
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NOTE: Presently not supported on Mac.
If Color Inspection Mode is enabled, a second portion of the Color Inspector window, featuring
Pantone-related functionalities, displays too whenever the Color Inspector is selected.

Color Inspector

Color Point Detalls

Color Inspector Window

6.3.7 Marquee Zoom

To select an area in the image to magnify:

e Click Marquee Zoom !:
e Select the area using the crosshairs that appear and the left button of your mouse
—  Or scroll upward with the track wheel.

To reduce the magnification:

e Place the cursor in the Sample panel.
e Scroll downward with the track wheel.

To pan:
e Left-click in the Sample panel. Hold and move the mouse around the panel.

6.3.8 Reset View

To restore the image to its original size:

A
e Click Reset View .

6.3.9 Save View

To save an image to a file:
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e Click the Image to Display icon in the Sample toolbar and then choose either the Master,
Sample, Difference, or Edge image. To save the view in the Master panel skip this step.

e Click Save View E] in either the Master or Sample toolbar. The Save As window displays with
the file type .tif as the default.
e Select the desired file type and storage location and click Save.
NOTE: The Flash Image cannot be saved.

6.4 Layouts

6.4.1 Creating Layouts

The Inspection View contains panels that let you review the graphics inspection results and add levels
and comments to differences. These panels constitute your layout and can be displayed or hidden as
required. For example, if your images do not have repeats, you may want to hide the Repeats found
panel. Layout customization is ideal for multi-monitor configurations, as panels can be placed on separate

displays. To view the different layout panels that can be loaded, click Menu E [ Layout.

ayout

Reset Layout

Layout Drop-Down Menu (Graphics Inspection)

To display/ hide the panels:

e Uncheck the panel name in the Layout drop-down menu or click the X in the top-right corner of
the panel once it has been loaded to hide it.
e Check the name of a hidden panel in the Layout drop-down menu to display it.

To move a given panel:

e Click its title bar, hold down, and shift it to one of the empty areas in the margins of your screen.
To save your layout so that it re-appears as is upon closing and re-opening the Application:

e Click Save Layout.
To reset your layout to the default:

e C(Click Reset Layout.
6.5 Overview Panel
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The Overview panel displays the original Sample image. The difference that is selected is located at the
intersection of the two red lines.

To zoom in or out of the Sample image in the Overview panel:

e Slide the button in the middle of the bar accordingly.

X 3 Overview

Overview Panel

6.6 Repeats Found Panel

The Repeats found panels lists the number of repeats of the Master image that were found in the
Sample file after the inspection has been run. Repeats with differences display a red icon to the left.
Repeats without differences display a green check mark to the left instead.

To navigate between repeats:
e Click the desired number on the list.
e The selected repeat appears in the Inspection View Sample panel.

X @ Repeats found: 3

) Repeat 2 Row 2 Col 1

) Repeat 3 Row 3 Col 1

Repeats Found Panel

6.7 Difference List and Details Panels

The Difference List displays the differences between the Master and Sample images for easy reviewing
and proofing. The Difference Details panel lets you assign comments and levels to selected differences
and include or exclude them from your report.

To select a difference:

e Click it in the Difference List. It gets highlighted. The corresponding difference gets highlighted in
the Inspection View Sample panel.

To assign a level to the difference:

e Select a level in the Level drop-down list in the Difference Details panel
— Or click in the Level column beside the difference in the Difference List.
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e The level appears beside the difference in the Difference List.

x & Differences found: 16

Type Levvel
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Change

Change
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gnore
Change

Change

Change

Change

Level Column in Difference List

To assign a comment to a difference:

Select a comment in the Comments drop-down box or type in a custom comment.
A sticky-Note icon displays in the Difference List to the right of the difference, signifying the
presence of a comment.

% @ Difference Details

Repeat 1 Difference 1

Comments

Calor
Registration
Text

Image
Barcode
Braille

Comments Drop-Down List

To exclude the difference from the report, assuming Force inclusion of all differences (Exclude
Differences) has not been checked:

e Click Exclude.
e The difference gets crossed out in the Difference List and the next difference then gets selected.
To cancel the exclude, select the difference again and click Include (F11).

To navigate to the next difference:

e Click Include,
—  Or press the F11 key,
— Orclick on the desired difference in the Difference List,
— Or press the DOWN ARROW | key. In each case, the difference gets included in the report.

To navigate to the previous difference:
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e Press the UP ARROW 1 key.

6.8 Inspections Panel

The Inspection View contains the Inspections panel, which lists completed inspections. For example,
you may run multiple inspections prior to generating the report. The Application lets you rename the
inspections and/ or exclude them from the report.

X & |Inspections

2 Graphics Sir  Rename

3 Graphics Sir s Exclude from report
4 Graphics Single Page
5 Graphics Single Page

Inspections Panel

To rename the inspection:

Right-click on the inspection name in the Inspections panel.
Click Rename.

Enter the desired name and click OK.

The new name displays in the Inspections panel.

To exclude the inspection from the report:

e Right-click on the inspection name in the Inspections panel.
e Click Exclude from report.
e The inspection name gets crossed out in the Inspections panel.

X & |nzpections

2 Graphics Single Fage
3 Graphics Single Page
4 Graphics Single Page

e The inspection is not included in the next generated report.

6.9 Master Panel

Unchecking Master Panel in the Layout drop-down menu hides it from view. The Sample panel takes up
the entire Inspection View area as a result. To make the Master re-appear, simply check it again. It is
checked by default.
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7. Text Inspection

Text Inspection Mode lets you compare either left-to-right, right-to-left, or Asian copy in master and
sample files whether they are digital or scanned in to the system (using OCR; See Optical Character
Recognition (OCR)). The Master and Sample can be two different file types laid out differently or with
similar layouts (revisions).

7.1 Step-by-Step

This section describes the steps to follow when running a text inspection.

7.1.1 Master Panel

Click File Menu [ Load Master or click in the Master panel to select the file to load.
The Master image loads in the Master panel.

If the file is a PDF:

- Theintegrated PDF Viewer displays (PDF Viewer).

- Prepare the Master image using the PDF Viewer tools, if required.

e Click File Menu [0 Load Sample or click in the Sample panel to start repeating the process
to load sample files.

1=
o Ensure the Text Inspection Mode Icon Is Selected
e Compare (All Pages) should be selected in the Action drop-down menu.

7.1.2 Select Profile

e Click the Profile drop-down menu to access the Application’s library of available profiles.

Profile
" Different Layout (Cartons and Labels)

Ditferent Layout (In and Booklets)

Same Layout (Revisi

hanage
Profile Drop-Down Menu

The following default profiles are installed with the system:

PROFILE FILE TYPES (MASTER AND SAMPLE)

Different Layout (Cartons | Two electronic files with different layouts, like a Word doc and one
and Labels) featuring laid-out carton/ labels

Different Layout (Inserts Two electronic files with different layouts, like a Word doc and one
and Booklets) featuring a laid-out booklet/ insert

Same Layout (Revisions) | Two electronic files sharing the same layout to be inspected for revision
purposes (minor changes expected)

e Ensure the Proper Inspection Area Is Selected.
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Use master/ sample tools to crop, rotate the image, etc. See Sections Master Toolbar to Sample
Toolbar, including Page Selection toolbar and Optical Character Recognition (OCR) in case of (a)
scanned file(s).

7.1.3 Run the Inspection

e Click m The files are inspected and the differences display in the Inspection View.

savings tOD|FIN r
es only eight sees only 8 seconc

¥ i g 5]
§BEAER" 188RH.

Inspection View

7.1.4 View the Results

To view the inspected file:

Use the track wheel to zoom in or out.

Hold the left mouse button and move it around to pan the image.

To review multiple pages, navigate through them using the Page Navigation drop-down list at
the bottom left of the Inspection View.

Page Navigation

7.1.5 Review and Proof the Differences

To select a difference:

e Click on the difference in the Difference List.
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Difference List

e It gets highlighted in the Inspection View and displays in the Change Grid below the two panels.
The characters in yellow in the Change Grid represent the differences between the Master and
Sample panels.

NOTE: Scroll over a character in the Change Grid to display its Unicode value.

: Difference Highlighted in Inspection View
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Change Grid

Difference #7 Selected

Change Grid

To assign a level to a difference:

e Select the difference in the Difference List. Click the Level drop-down box and select the level.
NOTE: Hot keys (F1 — F5) may be applied to assign levels. Select the difference and click the
appropriate “F” key (see below):

KEY FUNCTION

F1 Reporting level - Critical
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F2 Reporting level - Major
F3 Reporting level - Minor
F4 Reporting level - Ignore
F5 Reporting level — None

Comment Level Level

Drop-Down
:Select comments Mone List

Majar
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Level Drop-Down List

To assign a level to multiple differences:

e Hold down CTRL while selecting the differences, click the Level column, and select the level.
NOTE: On a Mac operating system, to assign a level to multiple differences, hold down the
COMMAND and SHIFT keys while selecting the differences, click the Level column, and select
the level.

To remove a level assignment:

o Click the Level column and select None. The level no longer displays in the Difference List.

To assign comment to a difference:

e Select the difference in the Difference List. Click the Comment column and select one of the
predefined comments that appear. The selected comment displays. Descriptors (or system
comments) appear as the default for Change, Size, Font Type, Bold, Italic, Hyphen, Underline,
Color, Line Break Space, and Sub/Super-type differences.

NOTE: Select System Comments in the drop-down to reset the default comment for that specific
difference.

To assign a comment to multiple differences:

e Hold down the CTRL key while selecting the differences, click the Comment column, and select
the comment.
NOTE: On a Mac operating system, to assign a comment to multiple differences, hold down the
COMMAND and SHIFT keys while selecting the differences, click the Comment column, and
select the comment.

To assign a customized comment to a difference:

e Select the difference in the Difference List, click the Comment column, select Freeform, and
type in the Comments text box in the Difference window that appears. Click OK for it to take
effect.
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Difference Window
To delete a comment from a difference:

e Click in the Comment column in the Difference List and select None.
To exclude a difference:

e Select the difference in the Difference List and click F12.
NOTE: An administrator can configure the Application to force the inclusion of all differences, in
which case clicking F12 does not have an effect.

7.1.6 Include Inspections in Report
The Application lets you rename inspections and/ or exclude them from the report. This option is available
under the Inspections panel.
To rename the inspection:

Right-click on the inspection name in the Inspections panel.
Click Rename.

Enter the desired name and click OK.

The new name displays in the Inspections panel.

To exclude the inspection from the report:

Right-click on the inspection name in the Inspections panel.

Click Exclude from report.

The inspection name gets crossed out in the Inspections panel.

The inspection is not included in the next generated report.

NOTE: For more information on layouts and the panels available to you, see Layouts.

7.1.7 Generate the Report

Click the Report icon.
e See Generating Reports for step-by-step instructions.

7.1.7.1 Retain Inspection Results and Run a New Inspection

e Click Back . The Main View displays with the Master and Sample images loaded.
e Toload new files, follow the steps above.
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e Click m The files are inspected and the differences display in the Inspection View. Each
subsequent retained inspection gets listed in the Inspections panel.

7.1.7.2 Clear Inspection Results and Run a New Inspection

e Click Reset . The following message displays, asking if you want to continue:

.9

Inspecticns and Documents will be cleared. Click Yes
o continwe.

e Click Yes to clear inspections and documents. The Main View displays with the profile selected.

7.2 Text Inspection Master Toolbar

The Text Inspection Master toolbar appears above the Inspection View Master panel once a text
inspection has been run. It contains the following tools:

C /X

Text Inspection Master Toolbar

7.2 Rotate

To rotate the Master image:
('\
e Click Rotate .
e Select Rotate 90 CW or Rotate 90 CCW.

7.2.2 Color Inspector

To display the RGB, CMYK, and LAB color-space information for a selected area in the Master file:

e Click the Color Inspector .
Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB
color-space values of the color at the point selected.
NOTE: Presently not supported on Mac.
If Color Inspection Mode is enabled, a second portion of the Color Inspector window, featuring
Pantone-related functionalities, displays too whenever the Color Inspector is selected.

7.2.3 Marquee Zoom

To select an area in the image to magnify:

e Click Marquee Zoom |
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e Select the area with the crosshairs by left-clicking
—  Or scroll upward with the track wheel.

To reduce the magnification:

e Place the cursor in the Master panel.
e Scroll downward with the track wheel.

To pan:
e Left-click in the Master panel. Hold and move the mouse around the panel.

7.2.4 Reset View

To restore the image to its original size:

XA
e Click Reset View .

7.2.5 Save View

To save an image to a file:

e Click Save View on the bar. The Save As window displays with .tif as the default file type.
e Select the desired file type and storage location and click Save.

7.3 Text Inspection Sample Toolbar

The Text Inspection Sample toolbar appears above the Inspection View Master panel once a text
inspection has been run and contains the following tools:

- C /A8 X &

Text Inspection Sample Toolbar
7.3.1 Resync Tool

=
The Resync Tool * icon may be clicked to remove an undesired difference that is an identical match
between the Master and Sample from the inspection results.

To resync a difference:

e Click the Underline Text icon underneath the Master panel and click and drag the
crosshairs to select the difference in question. The text gets underlined in blue.
- Alternatively, right-click on the difference in the Difference List and choose Select on
master in the menu that pops up. The text in question gets underlined in blue.

Select on master
E

elect on sample

NOTE: If there is a match on the Sample, it shows up in the Resync panel that appears. Clicking a
match zooms in on that selection on the Sample to be highlighted.
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e Repeat either process for the Sample panel to highlight the same text.

=Y
Click the Resync Text * icon.
The difference is removed from the Difference List and the amount of differences detected are
re-numbered.
NOTE: If the differences are not identical, the difference type gets reclassified as Change and
does not get removed; A resynched difference can also not be undone. The inspection must be
rerun to get it back.

To clear a selection:

e Right-click on the text underlined in blue.
e Select either Clear, to clear the underline from the word, or Clear All, to clear all underlines, in
the menu that pops up.

7.3.2 Rotate

To rotate the Master image:

e Click Rotate .

e Select Rotate 90 CW or Rotate 90 CCW.

7.3.3 Color Inspector

To display the RGB, CMYK, and LAB color-space information for a selected area in the Sample file:

e Click the Color Inspector .

e Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB
color-space values of the color at the point selected.
NOTE: Presently not supported on Mac.

If Color Inspection Mode is enabled, a second portion of the Color Inspector window, featuring
Pantone-related functionalities, displays too whenever the Color Inspector is selected.
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Color Inspector Window
7.3.4 Marquee Zoom

To select an area in the image to magnify:

e Click Marquee Zoom [+ .
e Select the area using the crosshairs that appear and the left button of your mouse
—  Or scroll upward with the track wheel.

To reduce the magnification:

e Place the cursor in the Sample panel.
e Scroll downward with the track wheel.

To pan:
e Left-click in the Sample panel. Hold and move the mouse around the panel.

7.3.5 Reset View

To restore the image to its original size:

A
e C(Click Reset View .

7.3.6 Save View

To save an image to a file:

e Click Save View on bar. The Save As window displays with the file type .tif as the default.
e Select the desired file type and storage location and click Save.

7.4 Layouts
7.4.1 Create Layout
The Inspection View contains panels that let you review the text inspection results. These panels

constitute your layout and can be displayed or hidden as required. Layout customization is ideal for multi-
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monitor configurations, as panels can be placed on separate displays. To view the different layout panels

that can be loaded, click Menu E [J Layout.

Layout Drop-Down Menu (Text Inspection)

To display/ hide the panels:

e Uncheck the panel name in the Layout drop-down menu or click the X in the top-right corner of
the panel once it has been loaded to hide it.
e Check the panel name to display it.

To move a given panel:

e Click its title bar, hold down, and shift it to one of the empty areas in the margins of your screen.
To save your layout so that it reappears as it is upon closing and re-opening the Application:

e C(Click Save Layout.
To reset your layout to the default:

e C(Click Reset Layout.

7.5 Difference Llst

The Difference List displays the differences between the Master and Sample files for easy reviewing and

proofing. The column headings include the Filter Differences Y icon, ID, Page, Type, Master (the
difference as it appears in the Master), Sample (the difference as it appears in the Sample), Comment,
and Level. With exception to the Filter Differences icon, click any heading to sort the list based on the
contents of that column. By default, the list is sorted by the Difference ID.

Difference List
To select a difference:

e Click it in the Difference List.
e It gets highlighted in the Inspection View Master and Sample panels.
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Difference
List

Inspection View

To filter the differences, so only specific types appear:

e Click the Filter Differences Y icon.
e The Filter window appears.

Filter Window

e Ensure the difference types desired to appear in the Difference List are checked by either:
— Checking/ unchecking them individually,
— Clicking Select/deselect all, which toggles all difference types on or off, or
— Clicking Defaults, which resets the selections.

e Click Filter to return to the filtered Difference List and see the desired difference types or click
Cancel to disregard the selections and close the window.
NOTE: Differences excluded from the Difference List via the Filter function still appear in the
generated report.

To assign a level to the difference:

e Select a level by clicking in the Level column in the Difference List and making the selection
from the drop-down list that appears. The color-coded level displays in the Difference List to the
right of the difference.

Page 100 Published 14 January 2021
By GlobalVision, Inc.



GlobalVision Mac 5.8.2 User Guide
Rev 002

Lewvel

Hong
Critieal
Majar

. Mirsar

Igniore

Level Column in Difference List

To assign a comment to a difference:

e Select a comment by clicking in the Comment column or type in a custom one (by selecting
Freeform).

Comment

Comment Column in Difference List

To exclude the difference from the report:

Select the difference in the Difference List and click F12.

e The difference gets crossed out in the Difference List and the next difference gets selected. To
cancel the exclude, select the difference again and click F11 to include it.
NOTE: An administrator can configure the Application to force the inclusion of all differences, in
which case clicking F12 does not have an effect.

To navigate to the next difference:

e Press the F11 key,
- Or click on the desired difference in the Difference List,
- Or press the DOWN ARROW | key. In each case, the difference is included in the report.

To navigate to the previous difference:

e Press the UP ARROW 1 key.

7.6 Image Details Panel

The Image Details panel displays image differences during text inspections. Switching between
displayed differences is as simple as clicking on a new image difference in the Difference List. To assign
comments and levels to an image difference, follow the same processes outlined for other difference

types.
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NOTE: image differences only display when the Images difference type and the Include Images
comparison option are checked on in the selected profile. None of the default Text Inspection profiles
have either option checked. Only administrators and managers can create new profiles with these options
turned on. For more information, consult the Administration Guide.

7.7 Inspections Panel

The Inspection View contains the Inspections panel, which lists completed inspections. For example,
you may run multiple inspections prior to generating the report. The Application lets you rename the
inspections and/ or exclude them from the report.

X & |nspections

2 TextCom  Rename
ITextCom  Eyxclude from report

Inspections Panel
To rename the inspection:

e Right-click on the inspection name in the Inspections panel and click Rename.

L ] & Inspection

o Enter the desired name and click OK. The new name displays in the Inspections panel.
To exclude the inspection from the report:

e Right-click on the inspection name in the Inspections panel and click Exclude from report.
e The inspection name gets crossed out in the Inspections panel.

X & |Inspections

Z Text Compare (All Pages)
3 Text Compare (All Pages)

e The inspection is not included in the next generated report.
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7.8 Master Panel

Unchecking the Master Panel in the Layout drop-down menu hides it from view. The Sample panel takes
up the entire Inspection View area as a result. To make the Master re-appear, simply check it again. It is
checked by default.
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8. Spelling Inspection

Spelling Inspection Mode checks the spelling of a loaded file or scanned document (using OCR; See
Optical Character Recognition (OCR)). The Application verifies the text against any one of 37 different
featured languages to help ensure the quality of the copy on both packaging components and collateral.
Custom, company-specific terms can be added to any dictionary by administrators, while all loaded files
are automatically run against an English medical dictionary for increased inspection accuracy.

8.1 Step-by Step

This section describes the steps to follow when running a spelling inspection.

8.1.1 Load Files for Spelling Inspection

To inspect spelling in the Master panel:

e Click File Menu > Load Master or click in the Master panel to launch the load-file window.
- You can also load a file by using “drag and drop.”
The Master image loads in the Master panel.
If the file is a PDF:
- The integrated PDF Viewer displays (PDF Viewer).
- Prepare the Master image using the PDF Viewer tools, if required.

e Click m for the results to display in the Inspection View. To inspect spelling in the Sample
panel:

e Click File Menu > Load Sample or double-click in the Sample panel and follow the same
steps as above.

e Ensure the Spelling Inspection Mode Icon Is Selected

8.1.2 Load Files for Spelling Inspection
Action

repact Master (All Pages| -

nspect Sompls (All Poges|

Action Drop-Down Menu

To inspect the file in the Master panel for spelling:
e Click Action > Inspect Master (All Pages).
To inspect the file in the Sample panel for spelling:

e Click Action > Inspect Sample (All Pages).

8.1.3 Select a Language
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e Click the Profile drop-down menu to access the Application’s library of available languages.

Profile Drop-Down Menu

e Select the language that best suits your inspection needs from the drop-down menu.

NOTE: See Supported Dictionaries (Spelling Inspection) in the Appendix.

e Ensure the Proper Inspection Area Is Selected

e Use master/ sample tools to crop, rotate the image, etc. See Sections Master Toolbar to Sample
Toolbar for more information, including Master Image Adjustment or Optical Character
Recognition (OCR) in case the file is a scanned-in hard copy.

8.1.4 Run the Inspection

e Click m The files are inspected and the differences display in the Inspection View.

VvV \U/ w

reeHand
P

Inspection View

8.1.5 View the Results

To view the inspected file:

Use the track wheel to zoom in or out.

Hold the left mouse button and move it around to pan the image.

To review multiple pages, navigate through them using the Page Navigation drop-down menu at
the bottom left of the Inspection View.

8.1.6 Review and Proof the Differences
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To select a difference:

e Click on the difference in the Difference List.
e |t gets highlighted in the Inspection View.

To assign a level to a difference:

e Select the difference in the Difference List. Click the Level column and select the level in the
drop-down list that appears. The color-coded level displays in the Difference List to the right of
the difference.

NOTE: Hot keys (F1 — F5) may be applied to assign levels. Select the difference and click the
appropriate “F” key (see below):

KEY FUNCTION

F1 Reporting level - Critical

F2 Reporting level - Major

F3 Reporting level - Minor

F4 Reporting level - Ignore

F5 Reporting level — None

Difference List Lovel
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Levels Assigned Using Difference List

To assign a level to multiple differences:

e Hold down the CTRL key while selecting the differences, click the Level column, and select the
level.
NOTE: On a Mac operating system, to assign a level to multiple differences, hold down the
COMMAND and SHIFT keys while selecting the differences, click the Level column, and select
the level.

To remove a level assignment:
e Click the Level column and select None. The level no longer displays in the Difference List.
To assign comment to a difference:

e Select the difference in the Difference List. Click the Comment column and select one of the
predefined comments that appear. The selected comment displays.

To assign a comment to multiple differences:
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e Hold down the CTRL key while selecting the differences, click the Comment column, and select

the comment.
NOTE: On a Mac operating system, to assign a comment to multiple differences, hold down the
COMMAND and SHIFT keys while selecting the differences, click the Comment column, and

select the comment.
To assign a customized comment to a difference:

e Select the difference in the Difference List, click the Comment column, select Freeform, and
type in the Comments text box in the Difference window that appears. Click OK for it to take
effect.

L] Ditferenoe

Difference Window
To delete a comment from a difference:

e Click in the Comment column in the Difference List and select None. Click elsewhere for it to
take effect.

To assign a suggested replacement for a difference from the selected dictionary:

e Right-click on a difference and select the desired word that displays in the menu that pops up. It
appears under the Comment field in that row.

Spelling DocuProof

Spelling DocuProof

To add a detected spelling mistake to the selected dictionary (administrators and managers only):
e Right-click on a difference and select Add to current dictionary.
o Click OK to the confirmation message that appears.
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The following word was added to the
current dictionary:
DocuProof

NOTE: All instances of that same spelling mistake no longer appear as differences once it has
been added and the inspection is re-run.

To exclude a difference:
e Select the difference in the Difference List and click F12. The difference gets crossed out.

NOTE: An administrator can configure the Application to force the inclusion of all differences, in
which case clicking F12 does not have an effect.

8.1.7 Include Inspections in Report
The Application lets you rename inspections and/ or exclude them from the report. This option is available
under the Inspections panel.
To rename the inspection:

e Right-click on the inspection name in the Inspections panel.

X @ |Inspections

2 5pelling Ins;  Rename
3 Spelling Ins

4 5pelling Ins e .
5 Speiling Inspect Master

¢ from report

Inspections Panel

e C(Click Rename.
e Enter the desired name and click OK.
e The new name displays in the Inspections panel.

To exclude the inspection from the report:

e Right-click on the inspection name in the Inspections panel.
e Click Exclude from report.
e The inspection name gets crossed out in the Inspections panel.
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X & |nspections

2 Spelling Inspect Master
3 Speolling Inspect Master
a Spelling Inspect Master
5 Spelling Inspect Master

e The inspection is not included in the next generated report.
NOTE: For more information on layouts and the panels available to you, see Layouts.

8.1.8 Generate the Report

e C(Click the Report icon.
e See Generating Reports for step-by-step instructions.

8.1.8.1 Retain Inspection Results and Run a New Inspection

Click Back . The Main View displays with the Master and Sample images loaded.
To load new files, follow the steps above.

e Click m The files are inspected, and the differences display in the Inspection View. Each
subsequent retained inspection gets listed in the Inspections panel.

8.1.8.2 Clear Inspection Results and Run a New Inspection

e Click Reset . The following message displays, asking if you want to continue:

Inspections and Documents will be cleared. Click Yes
to continue.

e Click Yes to clear inspection results and documents. The Main View displays with the profile on
the title bar.

8.2 Spelling Inspection Toolbar

The Spelling Inspection toolbar appears above the Inspection View Master panel once a spelling
inspection has been run. It contains the following tools:

C /7 # ¥

PR 7

Spelling Inspection Toolbar
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8.2.1 Rotate

To rotate the Master image:

e Click Rotate .

e Select Rotate 90 CW or Rotate 90 CCW.

8.2.2 Color Inspector

To display the RGB, CMYK, and LAB color-space information for a selected area in the inspected file:

e Click the Color Inspector .

e Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB
color-space values of the color at the point selected.
NOTE: Presently not supported on Mac.
If Color Inspection Mode is enabled, a second portion of the Color Inspector window, featuring
Pantone-related functionalities, displays too whenever the Color Inspector is selected.

e Ul

Color Inspector Window

8.2.3 Marquee Zoom

To select an area in the image to magnify:

e Click Marquee Zoom [+ .
e Select the area with the crosshairs that appear and the left mouse button
—  Or scroll upward with the track wheel.

To reduce the magnification:

e Place the cursor in the Master panel.
e Scroll downward with the track wheel.

To pan:

o Left-click in the Master panel. Hold and move the mouse around the panel.
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8.2.4 Reset View

To restore the image to its original size:

A
e Click Reset View .

8.2.5 Save View

To save an image to a file:

e Click the Save View icon. The Save As window appears with .tif as the default file type.
e Select the desired file type and storage location and click Save.

8.2.6 Layouts
8.2.6.1 Create a Layout

The Inspection View contains panels that let you review the spelling inspection results. These panels
constitute your layout and can be displayed or hidden as required. Layout customization is ideal for multi-
monitor configurations, as panels can be placed on separate displays. To view the different layout panels

that can be loaded, click Menu E [J Layout.
To display/ hide the panels:

e Uncheck the panel in the Layout drop-down menu or click the X in its top-right corner to hide it.
e Check the panel name to display it.

To move a given panel:
e Click its title bar, hold down, and shift it to an empty area in the margins of your screen.
To save your layout so that it reappears as is upon closing and re-opening the Application:
e Click Save Layout.
To reset your layout to the default:
e Click Reset Layout.
8.2.7 Difference List
The Difference List displays the differences between the Master and Sample files for easy reviewing and
proofing. The column headings include the ID, Page, Type, Word, Comment, and Level. Click any
heading to sort the list based on the contents of that column. By default, the list is sorted by the
(Difference) ID.

Difference List

To select a difference:

e Click it in the Difference List.
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To assign a level to the difference:
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Comment Drop-Down List

To exclude the difference from the report:

e Select the difference in the Difference List and click F12.

e The difference gets crossed out in the Difference List and the next difference then gets selected.
To cancel the exclusion, select the difference again and click F11 to include it.
NOTE: An administrator can configure the Application to force the inclusion of all differences, in
which case clicking F12 does not have an effect.

To navigate to the next difference:

e Press the F11 key,
- Or click on the desired difference in the Difference List,
- Or press the DOWN ARROW | key. In each case, the difference is included in the report.

To navigate to the previous difference:
e Press the UP ARROW 1 key.
8.2.8 Inspection Panel
The Inspection View contains the Inspections panel, which lists completed inspections. For example,

you may run multiple inspections prior to generating the report. The Application lets you rename the
inspections and/ or exclude them from the report.

To rename the inspection:

e Right-click on the inspection name in the Inspections panel and click Rename.
e Enter the desired name and click OK. The new name displays in the Inspections panel.

To exclude the inspection from the report:

e Right-click on the inspection name in the Inspections panel and click Exclude from report.
e The inspection name gets crossed out in the Inspections panel.

X & Inspections

2 Spelling Inspect Master
3 Spelling Inspect Master
4 Spelling Inspect Master
5 Spelling Inspect Master

e The Inspection is not included in the next generated report.

8.2.9 Master Panel

Unchecking Master Panel in the Layout drop-down menu hides it from view. The Sample panel takes up
the entire Inspection View area as a result. To make the Master re-appear, simply check it on.
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9. Barcode Inspection

This chapter describes the process for inspecting files containing barcodes. Barcode Inspection Mode
detects and grades barcodes, displaying details like decodability, magnification, quiet zones, etc. See
Section 6.3.3 for information on each individual barcode parameter. Digimarc barcodes, which consist of
embedded barcode information in enhanced packaging, are supported through a separate licensed
module. Only administrators can create custom profiles that enable the feature or additional parameters
like grade output format (letters vs. numbers). For more information, see the Administration Guide.

9.1. Step-by-Step

This section describes the steps to follow when running a barcode inspection.

1. Load Electronic Files (Skip to No. 2 to Load Scanned Files)

To inspect barcodes in a master file:

e Click File Menu > Load Master or click in the Master panel to launch the load-file window.
— You can also load a file by using “drag and drop.”
The Master image loads in the Master panel.
If the file is a PDF:
— The integrated PDF Viewer displays (see Section 3.6 PDF Viewer).
— Prepare the Master image using the PDF Viewer tools, if required.

e Click m and the results display in the Inspection View.
To inspect barcodes in a sample file:

e Click File Menu > Load Sample or click in the Sample panel and follow the same steps as
above.

2. Load Scanned Files (Skip Over if Electronic Files Loaded)

-
e C(Click Load from Scanner imll > Select Source.

=
F

Scan Master (Ctrl + Shift + M)
Scan Sample (Ctrl + Shift + S)

Select Source

e Select the applicable scanner from the Scanner Selection window and click Select.
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Scanner Selection Window

=
e C(Click Load from Scanner > Scan Master to scan the Master document. Once scanned, the
image loads in the Master panel.

e Click Load from Scanner E > Scan Sample to scan the Sample document. Once scanned,
the image loads in the Sample panel.

3. Select the Barcode Inspection Mode Icon m
4. Select an Action

Acfion
Inspect Master

Inspect Sample
Inspect Master [All Pages)

Inspect Sample [All Pages)

Action Drop-Down Menu

To inspect a master file for barcodes:

e Click Action > Inspect Master (for masters placed in the Master panel).
To inspect a sample file for barcodes:

e Click Action > Inspect Sample (for samples placed in the Sample panel).
To inspect multi-page files or multiple files for barcodes:

e Click Action > Inspect Master (All Pages) (for masters placed in the Master panel).
e Click Action > Inspect Sample (All Pages) (for samples placed in the Sample panel).

5. Select Profile

e Click Profile.
e Select the profile that best suits your inspection needs from the drop-down menu.

Profile

Default

Rotated
Barcode Inspection Profiles
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PROFILE DESCRIPTION
Inspect master or sample files with barcodes in horizontal or vertical
Default ) .
orientations
Rotated Inspect master or sample files with rotated barcodes; Detection speed is

slightly slower

6. Run the Inspection

e Click m and the results display in the Inspection View.

7. Review

To navigate to a barcode, click on the barcode in the Barcodes found panel in the Inspection
View. The Barcode Details panel displays its parameters and grades/ values.

Barcodes found : 8

Barcodes Panel

Barcode Details Eﬂ

Barcode 6

A (87)
162.00 %
A (100.00)

A(89.01)

g

A (0.00)
A (4.00)

A (0.00)

g »
8 o

A (L:100% R:

Data Structure

b=
=

MNarrow Bar A (0.53 mm)

BWR. 0,28 mm
Wide To Marrow Ratio NfA

Wide Bar A

Gap NJA

Value

Deco

01234565

Human Readzble Value

01234565

Results Match

Barcode Details Panel
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e An overall (average) grade is determined for the barcode based on the values of the individual

parameters. These grades appear in the Barcode Details panel. For more details on each of the
available panels, including individual parameters and grades see Section 6.3 Layouts.

Consult the Barcode Scan Grid to find parameter grades for each of the selected barcode’s scan
lines (instead of the average).

NOTE: The Barcode Scan Grid appears only when 1D (linear) barcodes are inspected; The
grades can be set to appear as numbers or letters. Letters is the default setting, while the Grade
output format must be set to Numbers in the selected Barcode Inspection profile. Standard

users cannot create a new profile with the changed setting. Consult the Administration Guide for
more information.

= =] 0 8 E @
Q /. F & 0
Inspections Barcodes
Panel Found
Panel
Overview "
Panel - —
e
; Barcode
: Details
ol [ Panel
e
Barcode -
Scan Grid m
nn

sssssss

Inspection View

e Use the track wheel to zoom in or out of the image.
e Hold the left mouse button and move it around to pan the image.
e To review multiple pages, navigate through them at the bottom left of the Inspection View.

Page Navigation
8. Include Inspections in Report

The Application lets you rename inspections and/ or exclude them from the report after having conducted
several. This option is available under the Inspections panel.

To rename the inspection:

e Right-click on the inspection name in the Inspections panel.
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Inspections

odeln  Rename
de In

deln  Exclude from report
5 Barcode Inspect Master

Inspections Panel

e Click Rename, enter the desired name, and click OK.
e The new name displays in the Inspections panel.

To exclude the inspection from the report:

Right-click on the inspection name in the Inspections panel.

Click Exclude from report.

The inspection name gets crossed out in the Inspections panel.

The Inspection is not included in the next generated report.

NOTE: For more information on layouts and the panels available to you, see Section 6.3 Layouts.

9. Generate the Report

e Click the Report icon.
e See Chapter 4.5 Generating Reports for step-by-step instructions.
NOTE: If Digimarc support is enabled, all information regarding that aspect of the inspection is
found appended to the PDF report. No other action is required on the part of the user.
10. Clear Inspection Results and Run a New Inspection

To retain inspection results and run a new inspection:

Click Back . The Main View displays the Master/ Sample image.
To load a new file to be inspected, follow the steps above.

To run a new inspection with the same files, click m
Once the inspection is completed, both it and the previous inspection get listed in the
Inspections panel in your Inspection View.

To clear inspection results and run a new inspection:

e Click Reset . The following message displays, asking if you want to continue:

[ Reset *

Inspections and Documents will be cleared. Click Yes to continue.

Yes Mo

e Click Yes to clear inspection results and documents. The Main View displays.
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9.2. Inspection Toolbar

The Barcode Inspection toolbar contains the following tools:

R S o

Barcode Inspection Toolbar

9.2.1. Rotate

To rotate the Master/ Sample image:

e Click Rotate .

o Select Rotate 90 CW or Rotate 90 CCW.

9.2.2. Color Inspector
To display the RGB, CMYK, and LAB color-space information for a selected area in the inspected image:

e C(Click the Color Inspector .

e Click an area in the image. The Color Inspector window displays the LAB, CMYK, and RGB
color-space values of the color at the point selected.
NOTE: If Color Inspection Mode is enabled, a second portion of the Color Inspector window,
featuring Pantone-related functionalities, displays too whenever the Color Inspector is selected.
For more information, see Chapter 10 Color Inspection.

Color Point Details

Color Inspector Window
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9.2.3. Marquee Zoom

To select an area in the image to magnify:

e C(Click Marquee Zoom !
e Select the area using the crosshairs that appear and the left button of your mouse
—  Or scroll upward with the track wheel.

To reduce the magnification:

e Place the cursor in the Inspection View.
e Scroll downward with the track wheel.

To pan:

e Left-click in the Inspection View. Hold and move the mouse around the panel.

9.2.4. Reset View

To restore the image to its original size:

A
e Click Reset View .

9.2.5. Save View

To save an image to a file:

e Click Save View on the toolbar. The Save As window displays with the file type .tif as the
default.
e Select the desired file type and storage location and click Save.

9.3. Layouts

9.3.1. Creating a Layout

The Inspection View contains panels that let you review the barcode inspection results. These panels
constitute your layout and can be displayed or hidden as required. Layout customization is ideal for multi-
monitor configurations, as panels can be placed on separate displays. To view the different layout panels

that can be loaded, click Menu E > Layout.
To display/ hide the panels:

e Uncheck the panel name in the Layout drop-down menu or click the X in the top-right corner of
the panel once it has been loaded to hide it.
e Check the panel name to display it.

To move a given panel:
e Click its title bar, hold down, and shift it to one of the empty areas in the margins of your screen.

To save your layout so that it reappears as is upon closing and re-opening the Application:
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e Click Save Layout.
To reset your layout to the default:

o C(Click Reset Layout.

9.3.2. Barcodes Found Panel

To navigate to a barcode, click on the barcode in the Barcodes found panel in the Inspection View. The
Barcode Details panel displays its parameters and the accompanying grades/ values. The barcode itself
gets highlighted in the Inspection View.

9.3.3. Barcode Details Panel

When inspecting UPC or EAN barcodes, the Application determines whether a decoded value matches
the Human Readable Value (through Optical Character Recognition; OCR). A match displays in green. A
non-match displays in red. The panel’s upper portion meanwhile serves to list each of the selected
barcode’s individual parameters. The remainder of this section describes each of them. For more
information on how each parameter is graded, see Appendix 12.6.4 Grading Parameters.

Barcode Details Eﬂ

Barcode 6

Grade
Decodability
Magnification
Symbol Contrast
Min Edge Contrast
Modulation
Defects

Decode

Narrow Bar
BWR
Wide To Marrow Ratio

Wide Bar

£
=

Gap

Decoded Value

01234565

Human Readable Value

01234565

Results Match

Barcode Details Panel
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Barcode Parameters

1D/ COMPOSITE BARCODE PARAMETERS

Type Barcode type detected

Grade Overall grade for the barcode; See the table below for a list of barcode
grades

Decodability Ease of barcode identification; The Application assigns a grade from A-F

(100-0%)

Magnification

Percentage (+/- 10%) that a barcode has been magnified based on a
starting point of 100%; Based on width to accommodate truncated barcodes
and can vary from 80% to 200% except for Interleaved 2 to 5-type codes

Symbol Contrast

Difference in contrast between the darkest and the lightest parts of a
barcode; The system assigns a grade from A-F (100-0%)

Min Edge Contrast

Minimum contrast between a space and its adjacent bars; The Application
assigns a pass-or-fail grade (A or F) (100-0%)

Ratio between symbol contrast and minimum edge contrast; The Application

Modulation assigns a grade from A-F (100-0%)
Defects Amount of discrepancies in the reflectance of a barcode; The Application
assigns a grade from A to F (100-0%)
Determination of whether the barcode was generated correctly, with
Decode sufficient spacing between bars; The system assigns a pass-or-fail grade (A

orF; 4 or0)

Min Reflectance

Minimum reflectance value (darkest part of the barcode); The Application
assigns a pass-or-fail grade (A or F)

Max Reflectance

Maximum reflectance value (the lightest part of the barcode); The
Application assigns a rating from 100-0

BWR

Measure of the decrease in bar width needed to compensate for print gain;
The Application assigns a measurement in mm

Decoded Value

Decoded value of the selected barcode

Quiet Zone

Blank margins bordering a barcode; The Application assigns a pass-or-fail
grade (A or F; Left% and Right %)

Data Structure

Type of information that is embedded in the barcode; The Application
analyzes applicable barcodes as either having valid (A) or invalid (F) data
structures (GS1 data matrix and QR codes only)

Width of the narrow bars comprising the barcode in mm; Higher DPI values

Narrow Bar yield results that are more precise; The Application assigns a grade from A-
F
Width of the wide bars comprising the barcode in mm; Higher DPI values
Wide Bar yield results that are more precise; The Application assigns a pass-or-fail

grade (Aor F)
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Wide to Narrow Ratio

Ratio that determines narrow and wide bar widths (NB: WB); The
Application assigns a pass-or-fail grade (A or F)

Amount of space between the last black bar of one character and the first of

Gap another in mm; The Application assigns a pass-or-fail grade (A or F)
2D BARCODE PARAMETERS

Type Barcode type detected

Grade Overall grade for the barcode; See the table below for descriptions

Symbol Contrast

Difference in contrast between the darkest and the lightest parts of a
barcode; The Application assigns a grade from A-F (100-0%)

Ratio between symbol contrast and minimum edge contrast; The Application

Modulation assigns a grade from A-F
Determination of whether the barcode was generated correctly, with
Decode sufficient spacing between bars; The Application assigns a pass-or-fail

grade (AorF; 4 or 0)

Axial Non-Uniformity

Difference in length of the two axes of the barcode; The Application assigns
a grade from A-F (0-100%)

Grid Non-Uniformity

Vector deviation of the barcode from an ideal position; The Application
assigns a grade from A-F (0-100%)

Fixed Pattern Damage

Damage done to the pattern; The Application assigns a grade from A-F

Unused Error
Correction

Amount of unused error correction embedded in the barcode; The
Application assigns a grade from A-F

Decoded Value

Decoded value of the selected barcode

BWR Horizontal

Measure of the decrease in horizontal bar width needed to compensate for
print gain; The Application assigns a measurement in mm

BWR Vertical

Measure of the decrease in vertical bar width needed to compensate for
print gain; The Application assigns a measurement in mm

Data Structure

Type of information that is embedded in the barcode; The Application
analyzes applicable barcodes as either having valid (“A”) or invalid (“F”) data
structures (GS1 data matrix and QR codes only)

Cell Size

Height and width of a cell comprising the data matrix (QR code); The
Application assigns a measurement in mm

Quiet Zone

Blank margins bordering a barcode; The Application assigns a pass-or-fail
grade (A or F; Left% and Right %)
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Barcode Grades

GRADE COLOR DESCRIPTION

A Overall grade of 3.5 or higher; The barcode should scan easily the first
time with most barcode scanning equipment

B Overall grade of 2.5 - 3.5; The barcode may scan easily the first time and
there is a high probability of success if a second scan is performed
Overall grade of 1.5 - 2.5; The minimum most barcodes should achieve
Acceptable only if the barcode is printed on fiberboard

F Failing grade

N/A Verification grade of the barcode symbol is not supported

9.3.4. Inspections Panel

The Inspection View contains the Inspections panel, which lists completed inspections. For example,
you may run multiple inspections prior to generating the report. The Application lets you rename the
inspections and/ or exclude them from the report.

Inspections

odeln  Rename

3 ode In .
4Barcodeln  EXclude from report
5 Barcode Inspect Master

Inspections Panel

To rename the inspection:

e Right-click on the inspection name in the Inspections panel.
e Click Rename.

e Enter the desired name and click OK.

e The new name displays in the Inspections panel.

To exclude the inspection from the report:

e Right-click on the inspection name in the Inspections panel.
o Click Exclude from report.
e The inspection name gets crossed out in the Inspections panel.

Inspections

e The Inspection is not included in the next generated report.
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9.3.5. Overview Panel

The Overview panel displays the image or inspection currently being viewed in the Inspection View. The
selected barcode is located at the intersection of two red lines.

To zoom in or out of the Sample image in the Overview panel:

e Slide the button in the middle of the bar accordingly.

Inspections

| Inspection Being
Viewed in
Overview Panel

Inspections
Panel

Overview
Panel

Inspections and Overview Panels
(as They Appear when Inspecting 2D Barcodes, Without Barcode Scan Grid)

9.3.6. Master Panel

Toggling the Master Panel on/ off in the Layout drop-down menu shifts the file from appearing in the
Sample panel (regardless of whether it is a master or sample being inspected) to it taking up the entire
Inspection View. The latter is the default position.
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